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ABSTRAK

Telah dilaksanakan pembuatan sistem pengontrol cahaya untuk mengontrol kuat
penerangan cahaya lampu pijar pada ruang baca berdasarkan jumlah orang yang
masuk pada ruang baca. Sistem ini dibangun menggunakan sensor infra red
sebagai pendeteksi orang masuk dan Kluar dari ruang baca. Arduino uno sebagai
sistem pengendali seluruh sistem yang dibuat. Pengujian dilakukan dengan
beberapa tahap antara lain hubungan kondisi lampu terhadap jumlah orang yang
masuk dan kluar dari ruang baca serta pengujian hubungan antar kuantitas lux
cahaya lampu pijar terhadap jarak. Hasil penelitian ini menunjukan bahwa sistem
dapat mengontrol dan menjaga kesatabilan intensitas cahaya ruang baca
berdasarkan jumlah orang dan yang kluar dari ruang baca.

Kata kunci: Sensor, Intensitas Cahaya, mikrokontroler ATMega328 Arduino
uno.

ABTRACT

Has made the manufacture of light control system to control the powerful
illumination incandescent light bulbs in the reading room based on the number or
people entering the reading room. The system is built using infra red sensor as a
detector of people in and out of the den. Arduiniuno as control systems
throughout the system are made. Testing is done by several stages include light
conditions relation to the number of people in end out of the reading room as well
as testing the relationship between the quantity of lux incandescent light bulbs to
the distance. The results of this study indicate that the system can control and
maintain stable ligth intensity based on the number of people reading room and
coming out of the den.

Keywords: Sensor, Ligth Intensity, Arduino uno ATMega328 microcontroller
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BAB |

PENDAHULUAN

1.1. Latar Belakang

Membaca merupakan salah satu aktivitas yang memerlukan cahaya.
Penerangan cahaya yang direkomendasikan dalam aktivitas membaca yaitu 250
Lux (SNI No. 16-7062-2004). Berdasarkan penelitian yang telah dilakukan
Fathimahhayati (2012) dan Nursalim dkk (2012) menyatakan bahwa sebagian
besar intensitas penerangan cahaya pada ruang tempat berlangsung aktivitas
membaca tidak sesuai SNI (Standar Nasional Indonesia). Intensitas cahaya yang
tidak sesuai standar dalam proses membaca dapat menjadi salah satu penyebab
kerusakan organ penglihatan.

Berangkat dari masalah di atas saya mencoba mencari solusi bagaimana
agar dapat menyesuaikan standart intensitas penerangan yang cocok untuk ruang
baca agar manusia didalamnya tidak mengalami kerusakan organ penglihatannya
dengan mengangkat sebuah judul penelitian yang tidak lepas dari masalah
tersebut yaitu “Rancang Bangun Penerangan Listri Pada Ruang Baca

Menggunakan Sensor Manusia.

1.2. Perumusan Masalah
Adapun yang menjadi rumusan masalah dalam penelitian ini adalah :
1. Bagaimana merancang dan membuat sistem pengaturan penerangan lampu

secara otomatis pada ruang baca?



1.3.

1.4.

Bagaimana mengontrol intensitas cahaya lampu agar intensitas penerangan
pada ruang baca sesuai lingkungan sekitar?
Variabel apa yang dideteksi agar lampu mengeluarkan penerangan yang

sesuai pada ruangan baca?

Batasan Masalah

Yang menjadi batasan masalah dalam penelitian ini adalah :

Penelitian yang dilakukan berbentuk studi rancang bangun alat yang seluruh
komponen pembentuknya dijelaskan secara mendetail dan ilmiah dalam
laporan ini.

Ruang lingkup pembahasan meliputi perangkat hardware dan software.

Alat yang dirancang dan dibuat adalah dalam skala kecil yaitu hanya

mengontrol tiga buah lampu.

Tujuan Penelitian

Tujuan dari penelitian ini adalah :
Mampu merancang suatu sistem kontrol penerangan lampu pada ruang baca
secara hardware dan software dan dalam bentuk skala kecil dengan

menggunakan sebuah pengendali cerdas yaitu sistem Arduino Uno.

2. Dapat mengimplementasikan sebuah sensor agar penerangan cahaya lampu

3.

yang dikeluarkan sesuai yang dibutuhkan pada ruang baca.
Mampu mendeteksi jumlah orang yang masuk dan yang keluar pada ruang

baca agar dapat mengatur penerangan cahaya lampu yang harus dikeluarakan.



1.5. Manfaat Penelitian
Dari penelitian ini diharapkan dapat memberikan manfaat sebagai berikut :

1. Bagi pengguna, dapat memudahkan pengguna untuk mengontrol saklar listrik
walaupun berada jauh dari area peralatan yang akan dikontrol sehingga
meningkatkan efisiensi waktu aktifitas pengguna, menghilangkan rasa
kekhawatiran pengguna saat meninggalkan ruang baca tersebut yang kosong.

2. Bagi perkembangan IPTEK, sebagai bahan masukan dalam rangka
menciptakan peralatan guna menghemat energi listrik.

3. Bagi penulis, sebagai bahan pembelajaran dalam bidang perancangan sistem

operasi aplikasi pengontrolan intensitas cahaya berbasis mikrokontroler.

1.6. Sistematika Pembahasan

Sistematika penulisan Tugas Akhir ini adalah sebagai berikut:
BAB | PENDAHULUAN
Berisi latar belakang, perumusan masalah yang diteliti, tujuan dan manfaat
penelitian, pembatasan masalah yang diteliti, serta sistematika penulisan laporan.
BAB Il TINJAUAN PUSTAKA
Berisi tentang cakupan konsep dan teori-teori pendukung yang menjadi landasan
penyusunan tugas akhir.
BAB Il METODOLOGI PENELITIAN
Berisi tentang bagaimana metode penelitian dilakukan, yang meliputi bagaimana
cara pengambilan data, cara perancangan dan pembuatan alat serta pengujiannya.

BAB IV HASIL DAN PEMBAHASAN



Berisi tentang hasil dari segala bentuk pengujian alat yang dilakukan serta hasil
yang didapatkan akan dilakukan pembahasan secara mendetail.

BAB VI PENUTUP

Berisi tentang kesimpulan dan saran yang didapatkan dari penelitian yang

dilakukan.



BAB 11

TINJAUAN PUSTAKA

2.1 Tinjauan Pustaka Relevan

Telah dilakukan rancang-bangun sistem otomatisasi kontrol lampu
berdasarkan keberadaan orang didalam ruangan. Sistem kontrol lampu akan
menyala selama ada orang didalam ruangan, dan lampu akan mati ketika orang
meninggalkan ruangan. Keberadaan orang akan di deteksi oleh sensor passive
infrared (PIR). Jarak waktu respon dari sensor PIR KC7783R telah dicobakan,
dimana sensor hanya dapat mendetekasi objek selama 5,37 detik, namun dapat
diatasi dengan menggunakan program yang ditanamkan ke dalam mikrokontroler
AT89S51. Jarak maksimum yang dapat di deteksi sensor PIR adalah 4,3 meter
pada sudut 0° (lurus dari depan sensor), dan 2 meter pada sudut 30° (kekiri dan
kekanan). Sensor membutuhkan waktu pemanasan selama 25,52 detik. Relay
digunakankan untuk menghubungkan antara arus dc dan arus ac.(Wildian 2013)

Seiring perkembangan ilmu pengetahuan dan teknologi, saat sekarang
banyak muncul gagasan-gagasan bidang elektronika digital. Sistem digital
berkembang dengan adanya teknologi  mikrokontroler.  Sistem ini
menyederhanakan sistem yang masih konvensional menjadi otomatis dan lebih
ringkas. Tugas akhir ini dimaksudkan mengkaji pemanfaatan mikrokontroler
untuk otomatis lampu Ruangan. Umumnya lampu di dalam Ruangan masih
menggunakan saklar analog, sehingga pemilik rumah harus menyalakan dan
mematikan lampu secara manual. Adanya rangkaian pengontrol perangkat listrik,

pemilik rumah dapat mengontrol lampu dengan pewaktuan menyala dan mati



lampu secara otomatis sesuai kebutuhan. Proses otomatisasi tersebut dikontrol
menggunakan program mikrokontroler sehingga dapat mengerakan relay dan
mengontrol lampu. Penyusunan laporan tugas akhir ini memerlukan metode
observasi, metode interview, metode dokumentasi dan metode studi pustaka. Dari
hasil uji coba yang telah dilakukan menunjukkan bahwa rangkaian ini bekerja
dengan baik.(syafaat 2014)

Telah dilakukan pembuatan sistem pengontrol cahaya untuk mengontrol
kuat penerangan cahaya pada ruang baca. Sistem ini dibangun menggunakan
sensor Light Dependent Resistor (LDR) sebagai pendeteksi intensitas cahaya.
Tegangan analog LDR diolah oleh mikrokontroler ATMegal6 untuk mengontrol
tiga buah lampu sebagai sumber penerangan ruang baca. Pengujian dilakukan
dengan membandingkan hasil pengukuran intensitas cahaya alat hasil rancangan
denganalat standar. Hasil penelitian ini menunjukkan bahwa sistem dapat
mengontrol dan menjaga kestabilan intensitas cahaya ruang baca dalam rentang
300—400Lux.(Nurhasanah 2015)

Keamanan gedung dan rumah mewah sangat diperlukan untuk mengatasi
tindak kejahatan seperti pencurian dan perampokan. Untuk pengamanan gedung
dan rumah mewah diperlukan sebuah sistem pengamanan yang dapat
diaplikasikan atau digunakan oleh suatu perusahaan. Salah satunya adalah sistem
keamanan dengan menggunakan sensor Passive Infra Red (PIR) KC7783R dan
mikrokontroler ATmega8535 yang sudah di dukung dengan bahasa pemograman
C. Sistem keamanan gedung dan rumah mewah diantaranya menggunakan kamera
CCTV yang dipantau oleh operator yang diminta oleh pemilik gedung atau rumah

mewah tersebut. Kamera CCTV ada yang menggunakan sensor IR dan ultrasonik,



tetapi dalam penggunaannya juga dibutuhkan sumber sensor lain. Contohnya,
sensor otomatis yaitu PIR sensor dengan jangkauan yang cukup panjang.(Zain

2013)

2.2. Saklar Otomatis

Penggunaan saklar otomatis di ruang baca merupakan salah satu cara
operasi yang digunakan untuk mengendalikan beban listrik. Ide penggunaan
saklar otomatis ini muncul sebagai upaya menghindari pemborosan energi listrik.
Selain itu juga saklar otomatis dapat memudahkan operasi.

Dari segi ekonomis, dengan memasang saklar otomatis, maka keborosan
energi listrik dapat dihindari. Dan penggunaan energi listrik pun menjadi

terkontrol.

2.3. Smart Building

Perkembangan teknologi melaju dengan sangat pesat. Perkembangan
teknologi ini merupakan hasil kerja keras dari rasa ingin tahu manusia terhadap
suatu hal yang pada akhirnya diharapkan akan mempermudah kehidupan manusia.
Salah satu cara untuk mempermudah kehidupan manusia adalah dengan
membangun smart building.

Smart building sudah menjadi salah satu topik pembahasan dalam
karyatulis fiksi ilmiah selama bertahun-tahun, namun baru mulai dicoba untuk
diwujudkan pada awal abad ke 20 ketika pemakaian energi listrik telah meluas
hingga ke rumah-rumah dan mulai majunya teknologi informasi.

Smart building mengacu pada penggunaan teknologi informasi dan



komputer untuk mengendalikan peralatan yang berada di dalam bangunan
tersebut (seperti jedela atau lampu). Sistem yang beropersi dalam smartbuilding
dapat berupa sistem kontrol jarak jauh yang sederhana dari lampu-lampu hingga
sebuah sistem yang berbasis komputer atau mikrokontroler yang memiliki tingkat
kecerdasan yang bervariasi yang secara otomatis mengontrol peralatan yang
berada di dalam bangunan.

Elemen dalam sebuah sistem smart building terdiri dari sensor (seperti
sensor cahaya atau sensor suhu), pengontrol (seperti komputer atau
mikrokontroler) dan aktuator (seperti motor, relay, servo atau sakelar lampu).
Sebuah antarmuka antara manusia dengan mesin diperlukan, agar pemilik
bangunan dapat berinteraksi dengan sistem untuk memonitor atau mengontrolnya.

Antarmuka ini dapat berupa terminal khusus atau aplikasi yang berjalan
pada telepon genggam atau komputer tablet. Antarmuka tersebut berkomunikasi
dengan sitem melalui jaringan kabel atau wireless menggunakan satu atau lebih

protokol.

2.4. Arduino

Arduino adalah platform pembuatan prototipe elektronik yang bersifat
open-source hardware yang berdasarkan pada perangkat keras dan perangkat
lunak yang fleksibel dan mudah digunakan. Arduino ditujukan bagi para seniman,
desainer, dan siapapun yang tertarik dalam menciptakan objek atau lingkungan
yang interaktif.

Arduino pada awalnya dikembangkan di lvrea, Italia. Nama arduino

adalah sebuah nama maskulin yang berarti teman yang kuat. Platformarduino



terdiri dari arduino board, shield, bahasa pemrograman arduino, dan arduino
development environment. Arduino board biasanya memiliki sebuah chip dasar
mikrokontroler Atmel AVR ATmega8 berikut turunannya. Blok diagram arduino
board yang sudah disederhanakan dapat dilihat pada Gambar 2.1. Shield adalah
sebuah papan yang dapat dipasang di atas arduino board untuk menambah
kemampuan dari arduino board.

Bahasa pemrograman arduino adalah bahasa pemrograman yang umum
digunakan untuk membuat perangkat lunak yang ditanamkan pada arduino board.
Bahasa pemrograman arduino mirip dengan bahasa pemrograman C++.

Arduino Development Environment adalah perangkat Ilunak yang
digunakan untuk menulis dan meng-compile program untuk arduino.
ArduinoDevelopment Environment juga digunakan untuk meng-upload program

yangsudah di-compile ke memori program arduino board.

2.3.1. Arduino Uno

Arduino Uno adalah arduino board yang menggunakan mikrokontroler
ATmega328. Arduino Uno memiliki 14 pin digital (6 pin dapat digunakan sebagai
output PWM), 6 input analog, sebuah 16 MHz osilator kristal, sebuah koneksi
USB, sebuah konektor sumber tegangan, sebuah header ICSP, dan sebuah tombol
reset. Arduino Uno memuat segala hal yang dibutuhkan untuk mendukung sebuah
mikrokontroler. Hanya dengan menhubungkannya ke sebuah komputer melalui
USB atau memberikan tegangan DC dari baterai atau adaptor AC ke DC sudah
dapat membuanya bekerja. Arduino Uno menggunakan ATmegal6U2 yang

diprogram sebagai USB-to-serial converter untuk komunikasi serial ke computer
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melalui port USB. Tampak atas dari arduino uno dapat dilihat pada Gambar 2.2.

Adapun data teknis board Arduino Uno R3 adalah sebagai berikut:

1.

2.

9.

Mikrokontroler : ATmega328

Tegangan Operasi : 5V

Tegangan Input (recommended) : 7 - 12 V
Tegangan Input (limit) : 6-20 V

Pin digital 1/0 : 14 (6 diantaranya pin PWM)
Pin Analog input : 6

Arus DC per pin I/0 : 40 mA

Arus DC untuk pin 3.3 V : 150 mA

Flash Memory : 32 KB dengan 0.5 KB digunakan untuk bootloader

10. SRAM : 2 KB

11. EEPROM : 1 KB

12. Kecepatan Pewaktuan : 16 Mhz

NO NROETMN S
1 bt 1 ~ V¥

DIGITAL (PWM~) F &

Gambar 2.1 : Arduino uno
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2.3.2. Pin Masukan dan Keluaran Arduino Uno

Masing-masing dari 14 pin digital arduino uno dapat digunakan sebagai
masukan atau keluaran menggunakan fungsi pinMode(), digitalWrite() dan
digitalRead(). Setiap pin beroperasi pada tegangan 5 volt. Setiap pin mampu
menerima atau menghasilkan arus maksimum sebasar 40 mA dan memiliki
resistor pull-up internal (diputus secara default) sebesar 20-30 KOhm. Sebagai
tambahan, beberapa pin masukan digital memiliki kegunaan khusus yaitu:

1. Komunikasi serial: pin 0 (RX) dan pin 1 (TX), digunakan untuk
menerima(RX) dan mengirim(TX) data secara serial.

2. External Interrupt: pin 2 dan pin 3, pin ini dapat dikonfigurasi untuk
memicu sebuah interrupt pada nilai rendah, sisi naik atau turun, atau
pada saat terjadi perubahan nilai.

3. Pulse-width modulation (PWM): pin 3,5,6,9,10 dan 11, menyediakan
keluaran PWM 8-bit dangan menggunakan fungsi analogWrite().

4. Serial Peripheral Interface (SPI): pin 10 (SS), 11 (MOSI), 12 (MISO)
dan 13 (SCK), pin ini mendukung komunikasi SPI dengan
menggunakan SPI library.

5. LED: pin 13, terdapat built-in LED yang terhubung ke pin digital 13.
Ketika pin bernilai HIGH maka LED menyala, sebaliknya ketika pin
bernilai LOW maka LED akan padam.

Arduino Uno memiliki 6 masukan analog yang diberi label A0 sampai A5,

setiap pin menyediakan resolusi sebanyak 10 bit (1024 nilai yang berbeda).
Secara default pin mengukur nilai tegangan dari ground (0V) hingga 5V,

walaupun begitu dimungkinkan untuk mengganti nilai batas atas dengan
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menggunakan pin AREF dan fungsi analog Reference(). Sebagai tambahan
beberapa pin masukan analog memiliki fungsi khusus yaitu pin A4 (SDA) dan pin
A5 (SCL) yang digunakan untuk komunikasi Two Wire Interface (TWI) atau Inter

IntegratedCircuit (12C) dengan menggunakan Wire library.

2.3.3. Sumber Daya dan Pin Tegangan Arduino Uno

Arduino uno dapat diberi daya melalui koneksi USB (Universal Serial
Bus) atau melalui power supply eksternal. Jika arduino uno dihubungkan ke
kedua sumber daya tersebut secara bersamaan maka arduino uno akan memilih
salah satu sumber daya secara otomatis untuk digunakan. Power supplay external
(yang bukan melalui USB) dapat berasal dari adaptor AC ke DC atau baterai.
Adaptor dapat dihubungkan ke soket power pada arduino uno. Jika menggunakan
baterai, ujung kabel yang dibubungkan ke baterai dimasukkan kedalam pin GND
dan Vin yang berada pada konektor Power.

Arduino uno dapat beroperasi pada tegangan 6 sampai 20 Volt. Jika
arduino uno diberi tegangan di bawah 7 Volt, maka pin 5V akan menyediakan
tegangan di bawah 5 Volt dan arduino uno munkin bekerja tidak stabil. Jika
diberikan tegangan melebihi 12 Volt, penstabil tegangan kemungkinan akan
menjadi terlalu panas dan merusak arduino uno. Tegangan rekomendasi yang
diberikan ke arduino uno berkisar antara 7 sampai 12 Volt.

Pin-pin tegangan pada arduino uno adalah sebagai berikut:

1. Vin adalah pin untuk mengalirkan sumber tegangan ke arduino uno

ketika menggunakan sumber daya eksternal (selain dari koneksi USB

atau sumber daya yang teregulasi lainnya). Sumber tegangan juga dapat
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disediakan melalui pin ini jika sumber daya yang digunakan untuk
arduino uno dialirkan melalui soket power.

2. 5V adalah pin yang menyediakan tegangan teregulasi sebesar 5 Volt
berasal dari regulator tegangan pada arduino uno.

3. 3V3 adalah pin yang meyediakan tegangan teregulasi sebesar 3,3 Volt
berasal dari regulator tegangan pada arduino uno.

4. GND adalah pin ground.

2.4. Peta Memori Arduino Uno

Arduino Uno adalah arduino board yang menggunakan mikrokontroler
ATmega328. Maka peta memori arduino uno sama dengan peta memori pada
mikrokontroler ATmega328.
2.4.1. Memori Program

ATMega328 memiliki 32K byte On-chip In-System Reprogrammable
Flash Memory untuk menyimpan program. Memori flash dibagi kedalam
duabagian, yaitu bagian program bootloader dan aplikasi seperti terlihat pada
Gambar 2.3. Bootloader adalah program kecil yang bekerja pada saat sistem
dimulai yang dapat memasukkan seluruh program aplikasi ke dalam memori

prosesor.
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0x0000

Application Flash Section

—

Boot Flash Section

Ox3FFF

i 16 bits i

Gambar 2.2 : Peta memori program ATMega 328

2.4.2. Memori Data

Memori data ATMega328 terbagi menjadi 4 bagian, yaitu 32 lokasi untuk
register umum, 64 lokasi untuk register 1/0, 160 lokasi untuk register 1/O
tambahan dan sisanya 2048 lokasi untuk data SRAM internal. Register umum
menempati alamat data terbawah, yaitu 0x0000 sampai 0Ox001F. Register 1/O
menempati 64 alamat berikutnya mulai dari 0x0020 hingga 0x005F. Register 1/O
tambahan menempati 160 alamat berikutnya mulai dari 0x0060 hingga OxOO0FF.
Sisa alamat berikutnya mulai dari 0x0100 hingga OxO08FF digunakan untuk
SRAM internal. Peta memori data dari ATMega 328 dapat dilihat pada Gambar

2.4.
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32 General 0x0000
Purpose Working
Registers
Ox001F

64 I/O Registers | 0x0020

Ox005F

160 Extended 0x0060
I/O Registers

Ox00FF
Internal SRAM 0x0100

Ox08FF

HS bits ————»

Gambar 2.3 : Peta memori data atmega 328

2.4.3. Memori Data EEPROM

Arduino uno terdiri dari 1 KByte memori data EEPROM. Pada memori
EEPROM, data dapat ditulis/dibaca kembali dan ketika catu daya dimatikan, data
terakhir yang ditulis pada memori EEPROM masih tersimpan pada memori ini,
atau dengan kata lain memori EEPROM bersifat nonvolatile. Alamat EEPROM

dimulai dari 0x000 hingga Ox3FF.

2.5. Arduino Ethernet Shield

Ethernet Shield menambah kemampuan arduino board agar terhubung ke
jaringan komputer. Ethernet shield berbasiskan cip ethernet Wiznet W5100.
Ethernet library digunakan dalam menulis program agar arduino board dapat
terhubung ke jaringan dengan menggunakan arduino ethernet shield.

Pada ethernet shield terdapat sebuah slot micro-SD, yang dapat digunakan
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untuk menyimpan file yang dapat diakses melalui jaringan. Onboard micro-SD
card reader diakses dengan menggunakan SD library.

Arduino board berkominikasi dengan W5100 dan SD card mengunakan
bus SPI (Serial Peripheral Interface). Komunikasi ini diatur oleh library SP1.h dan
Ethernet.h. Bus SPI menggunakan pin digital 11, 12 dan 13 pada Arduino Uno.
Pin digital 10 digunakan untuk memilih W5100 dan pin digital 4 digunakan untuk
memilih SD card. Pin-pin yang sudah disebutkan sebelumnya tidak dapat
digunakan untuk input/output umum ketika kita menggunakan ethernet shield.

Karena W5100 dan SD card berbagi bus SPI, hanya salah satu yang dapat
aktif pada satu waktu. Jika kita menggunakan kedua perangkat dalam program
kita, hal ini akan diatasi oleh library yang sesuai. Jika kita tidak menggunakan
salah satu perangkat dalam program kita, Kiranya Kita perlu secara eksplisit men-
deselect-nya. Untuk melakukan hal ini pada SD card, set pin 4 sebagai output
danmenuliskan logika tinggi padanya, sedangkan untuk W5100 yang digunakan
adalah pin 10. DFRduino Ethernet shield adalah sebuah clone dari arduino
Ethernet shield yang dibuat oleh DFRobot. Penampakan DFRduino Ethernet

shield dapat dilihat pada Gambar 2.4.

FIFROBOV ! <L
wuu, DF Robot. com -

DFRdu1no [
Ethernet L
Shield V2.0

we H20648A0

@ vS0LL6uH B

Gambar 2.4 : Ethernetshield
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2.6. Bahasa Pemrograman Arduino

Arduino board merupakan perangkat yang berbasiskan mikrokontroler.
Perangkat lunak (software) merupakan komponen yang membuat sebuah
mikrokontroller dapat bekerja. Arduino board akan bekerja sesuai dengan perintah
yang ada dalam perangkat lunak yang ditanamkan padanya.Bahasa Pemrograman
Arduino adalah bahasa pemrograman utama yang digunakan untuk membuat
program untuk arduino board. Bahasa pemrograman arduino menggunakan
bahasa pemrograman C sebagai dasarnya.

Karena menggunakan bahasa pemrograman C sebagai dasarnya, bahasa
pemrograman arduino memiliki banyak sekali kemiripan, walaupun beberapa hal

telah berubah.

2.6.1. Struktur

Setiap program dalam arduino board terdiri dari dua fungsi utama yaitu
setup() dan loop(). Instruksi yang berada dalam fungsi setup() dieksekusi hanya
sekali, yaitu ketika arduino board pertama kali dihidupkan. Biasanya instuksi
yang berada pada fungsi setup() merupakan konfigurasi dan inisialisasi dari
arduino board. Instruksi yang berada pada fungsi loop() dieksekusi berulang-
ulang hingga arduino board dimatikan (catu daya diputus). Fungsi loop()
merupakan tugas utama dari arduino board. Jadi setiap program yang

menggunakan bahasa pemrograman arduino memilliki struktur sebagai berikut:
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void setup ()

{

'/ perintah-perintah untuk konfigurasi dan inisialisasi arduino board
}
void loop()
{

//perintah-perintah utama arduino board
}

Program di atas dapat dianalogikan dalam bahasa C sebagai berikut:

void setup (void); // prototipe fungsi setup
void loop(void); // prototipe fungsi loop
int main(wvoid) {
setup(); //
while(l) {
loop(); // ulangi terus menerus
}
return 0; //bagian ini tidak akan pernah dieksekusi
}

2.6.2. Konstanta
Konstanta adalah variable yang sudah ditetapkan sebelumnya dalam
bahasa pemrograman arduino. Konstanta digunakan agar program lebih
mudahuntuk dibaca dan dimengerti. Konstanta dibagi menjadi 3 kelompok yaitu:
1. Konstanta yang digunakan untuk menunjukkan tingkat logika
(konstanta Boolean), yaitu true dan false
2. Konstanta untuk menunjukkan keadaan pin, yaitu HIGH dan LOW
3. Konstanta untuk  menunjukkan  fungsi  pin, vyaitu INPUT,
INPUT_PULLUP dan OUTPUT
Konstanta yang digunakan untuk menunjukkan benar atau salah dalam
bahasa pemrograman arduino adalah true dan false. False lebih mudah

didefinisikan daripada true. False didefinisikan sebagai O(nol). True sering
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didefinisikan sebagai 1(satu), yang mana hal ini benar, tetapi true memiliki
definisi yang lebih luas. Setiap integer yang bukan nol adalah true dalam
pengertian Boolean. Jadi -2, 3 dan -100 semuanya didefinisikan sebagai true, juga
dalam pengertian Boolean. Tidak seperti konstanta yang lain true dan false diketik
dengan menggunakan huruf kecil.

Ketika membaca atau menulis ke sebuah pin digital, terdapat hanya dua
nilai yang dapat diberikan atau diterima, yaitu HIGH dan LOW. HIGH memiliki
arti yang berbeda tergantung apakah sebuah pin dikonfigurasi menjadi masukan
atau keluaran. Ketika pin dikonfigurasi sebagai masukan dengan fungsi
pinMode(), lalu kemudian dibaca dengan fungsi digitalRead(), mikrokontroler
akan melaporkan nilai HIGH jika tegangan yang ada pada pin tersebut berada
pada tegangan 3 volt atau lebih.

Ketika sebuah pin dikonfigurasi sebagai masukan, dan kemudian dibuat
bernilai HIGH dengan fungsi digitalWrite(), maka resistor pull-up internal dari
chip ATmega akan aktif, yang akan membawa pin masukan ke nilai HIGH
kecuali pin tersebut ditarik (pull-down) ke nilai LOW oleh sirkuit dari luar.

Ketika pin dikonfigurasi sebagai keluaran dengan fungsi pinMode(), dan
diset ke nilai HIGH dengan fungsi digitalWrite(), maka pin berada pada tegangan
5 volt. Dalam keadaan ini, pin tersebut dapat memberikan arus, sebagai contoh,
untuk menghidupkan LED yang terhubung seri dengan resistor dan ground, atau
pin lain yang dikonfigurasi sebagai keluaran dan diberi nilai LOW.

Sama seperti HIGH, LOW juga memiliki arti yang berbeda bergantung
pada konfigurasi pin. Ketika pin dikonfigurasi sebagai masukan, maka

mikrokontroler akam melaporkan nilai LOW jika tegangan yang terdapat pada pin
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berada pada tegangan 2 volt atau kurang. Ketika pin dikonfigurasi sebagai
keluaran dan diberi nilai LOW maka pin berada pada tegangan 0 volt.

Setiap pin pada arduino dapat dikonfigurasi sebagai masukan, masukan
dengan resistor pull-up atau keluaran. Untuk mengkonfigurasi fungsi pin pada
arduino digunakan konstanta INPUT, INPUT_PULLUP dan OUTPUT. Pin
arduino yang dikonfigurasi sebagai masukan dengan fungsi pinMode() dikatakan
berada dalam kondisi berimpedansi tinggi. Pin yang dikonfigurasi sebagai
masukan memiliki permintaan yang dangat kecil kepada sikuit yang di-sampling-
nya, setara dengan sebuah resistor 100 Megaohm dipasang seri dengan pin
tersebut. Hal ini membuat pin tersebut berguna untuk membaca sensor, tetapi
tidak untuk menghidupkan sebuah LED.

Cip ATmega pada arduino memiliki resisitor pull-up internal (resistor
yang terhubung ke sumber tegangan secara internal) yang dapat digunakan. Untuk
menggunakan resistor pull-up internal ini kita menggunakan konstatnta
INPUT_PULLUP pada fungsi pinMode().

Pin yang dikonfigurasi menjadi sebuah keluaran dikatakan berada dalam
kondisi berimpedansi rendah. Hal ini berarti pin tersebut dapat menyediakan
sejumlah besar arus ke sirkuit yang lain. Pin pada ATmega mampu menyediakan

arus hingga 40 mA.

2.6.3. Fungsi Masukan dan Keluaran Digital
Arduino memiliki 3 fungsi untuk masukan dan keluaran digital pada
arduino board, yaitu pinMode(), digitalWrite() dan digitalRead().

Fungsi pinMode() mengkonfigurasi pin tertentu untuk berfungsi sebagai
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masukan atau keluaran. Sintaksis untuk fungsi pinMode() adalah sebagai berikut:
pinMode(pin, mode)
Parameter: pin = angka dari pin digital yang akan dikonfigurasi
mode = konfigurasi yang diinginkan (INPUT, INPUT_PULLUP dan OUTPUT).
Fungsi digitalWrite() berfungsi untuk memberikan nilai HIGH atau LOW suatu
digital pin. Sintaksis untuk fungsi digitalWrite() adalah sebagai berikut:
digitalWrite(pin, value)
Parameter: pin = angka dari pin digital yang akan dikonfigurasi value = nilai
yang diinginkan (HIGH atau LOW).

Fungsi digitalRead() bertujuan untuk membaca nilai yang ada pada pin

arduino uno. Sintaksis untuk fungsi digitalRead() adalah sebagai berikut:

digitalRead(pin)
Parameter: pin = angka dari pin digital yang akan dibaca
Berikut ini adalah contoh penggunaan fungsi masukan dan keluaran digital

dalam sebuah program:

Int ledPin =13; /I LED terhubung ke pin digital 13
Int inPin =7; // push button terhubung ke pin digital 7
Int val = o; I variabel untuk menyimpan sebuah nilai

Void setup()

{

PinMode(ledpin, OUTPUT); /I set pin digital 13 sebagai keluaran

PinMode(inpin, INPUT); /I set pin digital 13 sebagai masukan

}
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Void loop()
{
Val = digitalRead(inpin); // baca nilai pin input

digitalWrite(ledpin, val); // sets LED sesuai dengan nilai val}

2.6.4. Progmem

Terkadang program dibuat memerlukan memori yang lebih besar,
misalnya kita perlu menyimpan banyak teks dalam sebuah program penampil
LCD. Hal ini bisa kita atasi dengan menyimpan data pada flash memori (memori
program). Besar memori program pada arduino uno adalah 32 KByte.

Kata kunci PROGMEM adalah sebuah variable modifier,PROGMEM
hanya bisa digunakan untuk tipe data yang di definisikan pada library
pgmspace.h. PROGMEM menjelaskan pada kompiler “letakkan informasi berikut
pada memori program”, menggantikan SRAM, dimana biasanya informasi
tersebut disimpan.

PROGMEM adalah bagian dari library pgmspace.h, jadi kita perlu
memasukkan library pgmspace.h ke program kita. Sintaksis untuk menggunakan
PROGMEM adalah sebagai berikut:
dataType variableName[] PROGMEM = {datalnt0, dataintl, ...};
dataType — tipe variable
variableName — nama array data

Karena PROGMEM adalah sebuah variable modifier, tidak ada aturan
yang baku untuk tempat peletakannya. Kompiler arduino menerima semua difinisi

yang ditunjukkan di bawah.



dataType variableName[] PROGMEM

&

dataType PROGMEM variableName[] = {};

PROGMEM dataType variableName[] = {};
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PROGMEM juga bisa digunakan untuk menyimpan satu variabel, tetapi

karena kerepotan dalam penggunaanya, sebaiknya hanya digunakan untuk

menyimpan data yang sangat banyak, yang biasanya lebih mudah menyimpannya

di dalam array.

Dalam menggunakan PROGMEM Kkita perlu melakukan 2 langkah

prosedur. Pertama adalah menyimpan data pada memori program, kemudian Kita

menggunakan fungsi khusus, yang juga didefinisikan di library pgmspace.h,

untuk membaca data tersebut dari memori program dan menuliskannya ke

SRAM, sehingga Kita dapat melakukan sesuatu dengan data tersebut.
Berikut adalah tipe data yang didukung oleh library pgmspace.h:
Prog_char  asigned char (1 byte) -127 sampai 128
Prog_uchar - anunsig char (1 byte) 0 sampai 255
Prog_intl6t - asigned int (2 bytes) -32,767 sampai 32,768
Prog_uint16_t- an unsgned int (2 bytes) 0 sampai 65,535
Prog_int32_t - asigned long (4 bytes) -2,147,483,648 sampai *
2,147,483,647
Prog_uint32_t- an unsigned long (4 bytes) 0 sampai 4,294,295
Berikut ini adalah contoh progam untuk menggunakan PROGMEM
#include <avr/pgmspace.h>
// simpan beberapa unsigned int

PROGMEM prog_uint16_t charSet[] = {65000, 32796, 16843, 10,
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11234};
I/ seimpan beberapa karakter
prog_uchar signMessage[] PROGMEM = {"UNIVERSITAS SUMATERA
UTARA"}
unsigned int displaylInt;
intk; /I variabel counter
char myChar;
/I baca int
displayInt = pgm_read_word_near(charSet + k)
Il baca karakter

myChar = pgm_read_byte near(signMessage + k);
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Di bawah ini adalah contoh program untuk menyimpan array string pada
program memori. Karena string sendiri adalah sebuah array, contoh di bawah ini
juga merupakan contoh penggunaan array dua dimensi.

#include <avr/pgmspace.h>

prog_char string_0[] PROGMEM = "String 0";
prog_char string_1[] PROGMEM = "String 1";
prog_char string_2[] PROGMEM = "String 2";
prog_char string_3[] PROGMEM = "String 3";
prog_char string_4[] PROGMEM = "String 4";

prog_char string_5[] PROGMEM = "String 5";

//buat table untuk menunjukkan string.
PROGMEM const char *string_table[] =
{

string_0,

string_1,

string_2,

string_3,

string_4,

string_5};
char buffer[30]; /Ipastikan buffer cukup untuk menympan string
void setup()

{

Serial.begin(9600);
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void loop()
{
/*menggunakan table string pada memori program membutuhkan
fungsi special untuk mengambil data tersebut.
fungsi strcpy P ("buffer™) menyalin sebuah string dari program

memori sebuah string di SRAM (“buffer”).

Pastikan bahwa SRAM cukup untuk menampung setiap string yang
diambil dari memori program*/
for (inti =0;i<6;i++)
{
strcpy_P(buffer, (char*)pgm_read_word(&(string_table[i]))); // salin
string ke buffer
Serial.printin( buffer ); delay(

500);

2.7. Arduino Development Environment

Arduino Development Environment terdiri dari editor teks untuk menulis
kode, sebuah area pesan, sebuah konsol, sebuah toolbar dengan tomol-tombol
untuk fungsi yang umum dan beberapa menu. Arduino Development Environment
terhubung ke arduino board untuk meng-upload program dan juga untuk

berkomunikasi dengan arduino board.
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Perangkat lunak yang ditulis menggunakan Arduino Developmen
tEnvironment disebut sketch. Sketch ditulis pada editor teks. Sketch disimpan
dengan file berekstensi .ino. Area pesan memberikan memberikan informasi dan
pesan error ketika kita menyimpan atau membuka sketch. Konsol menampilkan
output teks dari Arduino Development Environment dan juga menampilkan pesan
error ketika kita mengkompile sketch. Pada sudut kanan bawah dari
jendelaArduino Development Environment menunjukkan jenis board dan port
seriak yang sedang digunakan. Tombol toolbar digunakan utuk mengecek dan
mengupload sketch, membuat, membuka atau menyimpan sketch, dan

menampilkan serialmonitor.

'€ Smart_Building_120922 | Arduino 1.0.1 CSHRaTe > )

File Edit Sketch Tools Help

Smart_Building_120922
'/ (port 80 is default for HITP): -
Ethernetierver server(80);

char buffer[STRING_BUFFER_SPACE]:

PROGMEM prog_char http_respond_header[] = "HTTP/l.1 200 OK\nServer|
PROGMEM prog_char html headera[] "< !DOCTYPE HTML><html><head><ti
PROGMEM prog_char html headerb[] "<meta http-equiv=\"refresh\" c
PROGMEM prog_char html headerc[] "<div aligm=\"center\"><hl>Smar
PROGMEM prog_char html_footer[] = "</tr>\n</table>\n/div>\n\n</bo
PROGMEM prog_char html table_headera[] = “<table width=),"219," hei
PROGMEM prog char html table_headerb[] = "</th>\n<th width=}"63"

PROGMEM prog_char html_ table_satu[] = "</trx\n<tr><td><div align=Y ||
PROGMEM prog_char html table dua[] = "</div></td>\n{td><div align=
| PROGMEN prog_char html table tiga[] ="1%"><input type=subnit wvalue i\
PROGMEM prog_char html table_empat[] = "<form METHOD=get action=\"
PROGMEM prog_char html table lima[] = "0)"><input type=submit valu
PROGMEM prog_char html_table_enam[] = "</ /div></td>\n";

< | m | ’

Arduino Uno on COM1

Gambar 2.5 : Arduinodevelopment environment
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Berikut ini adalah tombol-tombol toolbar serta fungsinya:
o Verify
mengecek error pada code program.
% Upload
meng-compile dan meng-upload program ke Arduino board.
New
membuat sketch baru.
+ Open
menampilkan sebuah menu dari seluruh sketch yang berada di dalam
sketchbook.
* Save

menyimpan sketch.
#°  Serial Monitor

Membukaserial monitor.

Dalam lingkungan arduino digunakan sebuah konsep yang disebut
sketchbook, yaitu tempat standar untuk menumpan program (sketch). Sketch
yangada pada sketchbook dapat dibuka dari menu File > Sketchbook atau dari
tombol open pada toolbar. Ketika pertama kali menjalankan arduino devel
opmenten vironment, sebuah direktori akan dibuat secara otomatis untuk tempat
penyimpana sketchbook. Kita dapat melihat atau mengganti lokasi dari direktori
tersebut dari menu File > Preferences.

Serial monitor menampilkan data serial yang sedang dikirim dari

arduinoboard. Untuk mengirim data ke board, masukkan teks dan klik tombol

send atau tekan enter pada keyboard.
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Sebelum meng-upload program, kita perlu mensetting jenis board dan port
serial yang sedang kita gunakan melalui menu Tools > Board dan Tools >
SerialPort. Pemilihan board berguna untuk mengeset parameter (contohnya:
kecepatanmikrokontroler dan baud rate) yang digunakan ketika meng-compile
dan meng-upload sketch.

Setelah memilih board dan port serial yang tepat, tekan tombol upload
pada toolbar atau pilih menu File > Upload. Arduino board akan me-reset secara
otomatis dan proses upload akan dimulai. Pada kebanyakan board, LED RX dan
TX akan berkedip ketika program sedang di-upload. Arduino
developmentenvironment akan menampilkan pesan ketika proses upload telah
selesai, atau menampilkan pesan error.

Ketika sedang meng-upload program, arduino bootloader sedang
digunakan, Arduinp bootloader adalah sebuah program kecil yang telah
ditanamkan pada mikrokontroler yang berada pada arduino board. Bootloader ini
mengijinkan kita meng-upload program tanpa menggunakan perangkat keras

tambahan.

2.8. Sensor

Sensor adalah alat yang digunakan untuk mendeteksi dan sering berfungsi
untuk mengukur magnitude sesuatu. Dengan menggunakan sensor Kita dapat
mengubah mekanis, magnetis, panas, cahaya dan kimia menjadi tegangan dan
arus listrik. Sensor yang digunakan pada sistem kontrol intensitas penerangan

lampu pada ruang baca ini adalah sensor Infra Red.
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2.8.1. LedInfra Red

Infra merah merupakan gelombang cahaya yang tak tampak oleh mata
manusia. Panjang gelombangnya berada pada rentang 700 nm sampai 1 mm.
Panjang gelombang ini lebih panjang daripada panjang gelombang cahaya
tampak, tetapi tidak lebih panjang daripada panjang gelombang radio. Sumber
cahaya infra merah hampir sama dengan sumber cahaya tampak yaitu LED, tetapi
bahan pembuatnya berbeda. LED infra merah dibuat dari bahan gallium arsenide
(GaAs). LED infra merah hanya memerlukan tegangan masukan sebesar 3 Volt.

Berikut adalah Gambar 2.6 yang menampilkan bentuk fisik dari led infra merah :

Gambar 2.6 : Led infra merah

2.8.2. Fotodioda
Fotodioda adalah komponen elektronik yang terbuat dari bahan
semikonduktor dan dapat mengubah intensitas cahaya menjadi arus listrik dan

berikut bentuk fisiknya yang ditunjukkan pada Gambar 2.7 berikut :
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)

Gambar 2.7 : Fotodioda

Jika diperhatikan, skematik LED dan fotodioda hampir sama. Perbedaan
hanya terletak pada arah panahnya saja. Pada skematik LED, arah panahnya
keluar, yang dapat diartikan bahwa LED memancarkan cahaya. Pada skematik
fotodioda, arah panahnya masuk, yang dapat diartikan bahwa fotodioda menyerap
atau memproses cahaya.

Seperti pada LED, fotodioda juga memiliki dua kaki. Kaki yang lebih
panjang adalag anoda, dan kaki yang lebih pendek adalah katoda. Pemasangan
komponen fotodioda pada rangkaian elektronik berkebalikan dengan pemasangan
LED. Kutub positif atau anoda fotodioda dihubungkan dengan kutub negatif
sumber tegangan, dan kutub negatif atau katoda fotodioda dihubungkan dengan

kutub positif sumber tegangan.

2.9. Lampu Pijar

Lampu pijar adalah sumber cahaya buatan yang dihasilkan melalui
penyaluran arus listrik melalui filamen yang kemudian memanas dan
menghasilkan cahaya. Kaca yang menyelubungi filamen panas tersebut
menghalangi udara untuk berhubungan dengannya sehingga filamen tidak akan

langsung rusak akibat teroksidasi. Lampu pijar dipasarkan dalam berbagai macam
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bentuk dan tersedia untuk tegangan (voltase) kerja yang bervariasi dari mulai 1,25
volt hingga 300 volt.Energi listrik yang diperlukan lampu pijar untuk
menghasilkan cahaya yang terang lebih besar dibandingkan dengan sumber
cahaya buatan lainnya seperti lampu pendar dan dioda cahaya, maka secara
bertahap pada beberapa negara peredaran lampu pijar mulai dibatasi. Di samping
memanfaatkan cahaya yang dihasilkan, beberapa penggunaan lampu pijar lebih
memanfaatkan panas yang dihasilkan, contohnya adalah pemanas kandang ayam,
dan pemanas inframerah dalam proses pemanasan di bidang industri.

Pengembangan lampu pijar sudah dimulai pada awal abad XIX. Sejarah
lampu pijar dapat dikatakan telah dimulai dengan ditemukannya tumpukan
voltaoleh Alessandro Volta. Pada tahun 1802, Sir Humphry Davy menunjukkan
bahwa arus listrik dapat memanaskan seuntai logam tipis hingga menyala putih.
Lalu, pada tahun 1820, Warren De la Rue merancang sebuah lampu dengan cara
menempatkan sebuah kumparan logam muliaplatina di dalam sebuah tabung lalu
mengalirkan arus listrik melaluinya. Hanya saja, harga logam platina yang sangat
tinggi menghalangi pendayagunaan penemuan ini lebih lanjut.Elemen karbon juga
sempat digunakan, namun karbon dengan cepat dapat teroksidasi di udara; oleh
karena itu, jawabannya adalah dengan menempatkan elemen dalam vakum. Pada
tahun 1870-an, seorang penemu bernama Thomas Alva Edison dari Menlo Park,
negara bagian New Jersey, Amerika Serikat, mulai ikut serta dalam usaha
merancang lampu pijar. Dengan menggunakan elemen platina, Edison
mendapatkan paten pertamanya pada bulan April1879.

Rancangan ini relatif tidak praktis namun Edison tetap berusaha mencari

elemen lain yang dapat dipanaskan secara ekonomis dan efisien. Di tahun yang
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sama, Sir Joseph Wilson Swan juga menciptakan lampu pijar yang dapat bertahan
selama 13,5 jam. Sebagian besar filamen lampu pijar yang diciptakan pada saat itu
putus dalam waktu yang sangat singkat sehingga tidak berarti secara komersial .[2
Untuk menyelesaikan masalah ini, Edison kembali mencoba menggunakan
untaian karbon yang ditempatkan dalam bola lampu hampa udara hingga pada
tanggal 19 Oktober1879 dia berhasil menyalakan lampu yang mampu bertahan

selama 40 jam.

2.9.1. Konstruksi

Komponen utama dari lampu pijar adalah bola lampu yang terbuat dari
kaca, filamen yang terbuat dari wolfram, dasar lampu yang terdiri dari filamen,
bola lampu, gas pengisi, dan kaki lampu. Berikut ini adalah Gambar 2.9, yang

menjelaskan tetang bola lampu :


http://id.wikipedia.org/w/index.php?title=Sir_Joseph_Wilson_Swan&action=edit&redlink=1
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1. Bolalampu

2. Gas bertekanan rendah
(argon, neon, nitrogen)

3. Filamen wolfram

4. Kawat penghubung ke kaki
tengah

5. Kawat penghubung ke ulir

6. Kawat penyangga

7. Kaca penyangga

8. Kontak listrik di ulir

9. Sekrup ulir

10. Isolator

11. Kontak listrik di kaki

tengah

Gambar 2.8 : Bola lampu dan keterangannya

2.9.2. Bola Lampu

Selubung gelas yang menutup rapat filamen suatu lampu pijar disebut
dengan bola lampu. Macam-macam bentuk bola lampu antara lain adalah bentuk
bola, bentuk jamur, bentuk lilin, dan bentuk lustre. Warna bola lampu antara lain

yaitu bening, warna susu atau buram, dan warna merah, hijau, biru, atau kuning.
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2.9.3. Operasi

Pada dasarnya filamen pada sebuah lampu pijar adalah sebuah resistor.
Saat dialiri arus listrik, filamen tersebut menjadi sangat panas, berkisar antara
2800 derajat Kelvin hingga maksimum 3700 derajat Kelvin. Ini menyebabkan
warna cahaya yang dipancarkan oleh lampu pijar biasanya berwarna kuning
kemerahan.Pada temperatur yang sangat tinggi itulah filamen mulai menghasilkan
cahaya pada panjang gelombang yang kasatmata.Hal ini sejalan dengan teori
radiasi benda hitam.Indeks renderasi warna menyatakan apakah warna obyek
tampak alami apabila diberi cahaya lampu tersebut dan diberi nilai antara 0
sampai 100. Angka 100 artinya warna benda yang disinari akan terlihat sesuai
dengan warna aslinya. Indeks renderasi warna lampu pijar mendekati 100.Berikut

adalah Gambar 2.9, yang menunjukkan bentuk kawat filamen lampu pijar.

Gambar 2.9 : Kawat filament

2.10. AC/DC Adaptor

Sebagian besar piranti elektronika membutuhkan tegangan DC untuk
bekerja. Meskipun baterai berguna dalam piranti yang bisa dibawa-bawa atau
piranti berdaya rendah, akan tetapi waktu operasinya terbatas. Sumber daya yang
mudah dapat dibuat dari sebuah rangkaian yang dapat mengubah tegangan AC

menjadi tegangan DC.Sebuah adaptordapat dibuat dengan tiga buah komponen
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utama, yaitu transformer, dioda penyearah, dan kapasitor filter. Transformator
penurun tegangan adalah transformator yangdiperlukan untuk menurunkan
tegangan primer yang tinggi misalnyasebesar 220 Volt atau 380 Volt, menjadi
tegangan yang lebih rendah padabagian sekundernya, 6 Volt, 9 Volt, 12 Volt, atau
24 Volt. Berikut adalah Gambar 2.10 yang memperlihatkan bentuk fisik AC-DC

adaptor :

Gambar 2.10 : AC-DC Adaptor

2.11. Dasar - dasar ISP (In-System Chip Programming)

In-System Chip Programming (ISP) adalah sebuah fitur bagi sebuah
microcontroller agar dapat didownload dengan program tanpa mencabut
microcontroller dari system-nya. Sehingga Microcontroller tetap pada
kedudukannya semua dan dihubungkan dengan ISP. Dan dilakukan proses
download. Begitu pula saat memutuskan hubungan antara Downloader dan
Microcontroller, kita hanya cukup memutuskan kabelnya saja, tanpa lagi perlu
mencucuk-cabut microkontroler. Cara semacam ini adalah cara yang sangat hemat
waktu terutama dalam proses pengembangan sebuah program.

In-System Chip Programming(ISP) buatan ATMEL adalah sebuah

komunikasi serial yang menggunakan bus SPI (Serial Paripheral Interface) yang
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menggunakan Shift Register sebagai komponen utamanya. Ada 2 kabel data yang
disebut sebagai MISO (Master In Slave Out), dan MOSI(Master Out Slave In).
Sesuai dengan namanya jika ISP ini adalah sebuah downloader dan
microcontroller, maka dapat dikatakan Master adalah downloader dan Slave
adalah Microcontroller. MOSI adalah kabel yang mengirimkan data kepada Slave,
sedang MISO kabel tempat master menerima data. Transfer data tersebut
memerlukan sebuah kabel lagi, yang dinamakan sebagai shyncronization. Dalam
hal ini kabel tersebut dinamakan dengan SCK (Serial Clock). Data (MISO dan
atau MOSI) akan dianggap valid hanya saat SCK dalam keadaan tinggi. Berikut

ini adalah Gambar 2.11yang menampilkan bentuk fisiknya :

Gambar 2.11 : USB — AT ISP programmer download adapter



BAB IlI

METODOLOGI PENELITIAN

3.1. Tempat dan Waktu Penelitian

3.1.1. Tempat Penelitian

Pembuatan dan pengujian sistem kontrol penerangan listrik pada ruang
baca menggunakan sensor manusia dilakukan di :
1. Nama Tempat : Rumah Kontrakan

2. Alamat - JIn. Tangkul 1 No 110

3.1.2. Waktu Penelitian
Pembuatan dan pengujian sistem kontrol akuaphonik ini membutuhkan

waktu dengan rincian sebagai berikut :

1. Peyediaan bahan dan alat : 2 minggu
2. Perancangan seluruh sistem : 2 bulan
3. Pengujian sistem : 2 minggu
4. Penyusunan laporan Tugas Akhir 3 bulan

3.2. Metoda Penelitian

Pelaksanaan penelitian ini dilakukan dalam beberapa tahap untuk
mempermudah dan memperjelas arah penelitian.Berikut ini adalah Gambar 3.1,
yaitu flowchart kerangka berfikir dalam penelitian, dimana berdasarkan flowchart

inilah sebagai tahapan-tahapan yang dilakukan oleh peniliti dalam melakukan
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proses penelitian rancang bangun penerangan listrik

menggunakan sensor manusia:

C o D
v

Studi Pustaka

v

Mengidentifikasi Masalah

v

Menentukan Tujuan

v

Perancangan Alat
Hardware dan Software

v

I Mempersiapkan I

Alat dan Bahan

v

I Membuat Alat I

v

I Pengujian Alat

Tidak
Oke

39

pada ruang baca

Ya

I Penyusunan Laporan I

v
o=

Gambar 3.1 : Flowchart kerangka berfikir

3.2.1. Alat dan Bahan

Alat-alat yang digunakan pada pembuatan sistem adalah : 1 set tools

mechanic, gerinda, bor listrik, solder listrik, mistar, alat tulis. Alat-alat yang

digunakan pada uji kinerja alat rancangan antara lain : multimeter, dan testpen.
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Bahan yang digunakan dalam pembuatan sistem kontrol intensitas

penerangan lampu secara umum adalah seperti pada Tabel 3.1 berikut :

Tabel 3.1 : Penetapan komponen (bahan)

No. Komponen No. Komponen
1 | IC Mikrokontroler ATMega 328 11 | DownloaderAT ISP
2 | AC-DC Adaptor 12 VDC 12 | Sistem Minimum Arduino Uno
3 | DriverRelay 13 | PCB Polos
4 | Triplek 14 | Dioda H-Bridge
5 | Fotodioda 15 | Led Infra Merah
6 | IC Regulator 7805 16 | Konektor 2 kaki
7 | Konektor 4 kaki 17 | Lampu Pijar 5 Watt
8 | Resistor 18 | Sekrup
9 | Kabel Pelangi 19 | Lem Syetan
10 | Spicer 20 | Steker Listrik 220 VAC

3.2.2. Rancangan Struktural

a. Rancangan dan Pembuatan Kerangka

Bagian rangka berfungsi sebagai

dudukan setiap sistem-sistem yang

dirancang. Rangka terbuat dari triplek dengan dimensi ketebalan 0,1 cm,

panjang 32 cm, lebar 20 cm. Bentuk kerangka sebagai dudukan secara

keseluruhan adalah triplek persegi panjang. Dimensi yang dibuat adalah

bertujuan agar alat mudah dibawa kemana saja (portable). Rancangan rangka

dapat dilihat pada Gambar 3.2 di bawah ini yaitu skema dalam bentuk

diagram satu garis :
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20 cm

32cm

Gambar 3.2 : Rancangan kerangka alat

b. Rancangan dan Pembuatan AC-DC Adaptor
AC-DC adaptor yang dirancang adalah cukup menggunakan AC-DC adaptor
yang sudah jadi dan lebih simpel yaitu dengan membelinya di toko-toko
penjual komponen elektronika, namun hal yang harus diperhatikan adalah
spesifikasinya harus sesuai dengan kebutuhan sistem yang dirancang secara
keseluruhan. Berikut adalah Gambar 3.3 yang memperlihatkan bentuk fisik
AC-DC adaptor yang digunakan beserta spesifikasinya yang tertera di badan

adaptor :

Gambar 3.3 : AC-DC adaptor
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Pada Gambar 3.3 di atas yang memperlihatkan bentuk fisik AC-DC adaptor
dapat juga dilihat skema rangkaian didalamnya seperti Gambar 3.4 di bawah

ini:

Q MJ 2955
Dioda Bridge (with heat smk)
1A

S 1
220 VAC " AAA IC 7812
33 Ohm
T 0 5SW
| c1 c2 = | c3

[~ 2200 uF [~ 100 pF 0.1 uk

12V 1A

Lt
It
Lt

Gambar 3.4 : Skema rangkaian AC-DC adaptor

Rancangan dan Pembuatan Beban yang Dikendalikan

Seperti yang telah dijelaskan bahwa penelitian ini adalah mencoba
mengontrol penerangan lampu pada ruang baca, maka dalam hal ini ada pun
beban yang dikendalikan tentu sudah adalah lampu, namun lampu yang
dikendalikan adalah lampu pijar dengan spesifikasi daya 5 Watt dan bola
lampunya berwarna merah. Tetapi bukan berarti hanya lampu pijar saja yang
dapat dikendalikan semua lampu bisa dikendali menggunakan sistem yang
dibuat ini asalkan lampunya menggunakan tegangan input 220VAC. Berikut
adalah Gambar 3.5 yang memperlihatkan bentuk fisik lampu pijar yang

digunakan :
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Gambar 3.5 : Lampu pijar

Rancangan dan Pembuatan Driver Relay

Seperti yang telah dijelaskan sebelumnya bahwa driver relay adalah
rangkaian elektronika yang bisa mengendalikan pengoperasian sesuatu dalam
hal ini adalah relay. Relay yang memiliki spesifikasi tegangan kerja 12 VDC
tidak mungkin langsung bisa dikendalikan oleh output mikrokontroler,
sedangkan output maksimum mikrokontroler adalah sebesar 5 Volt. Oleh
sebab itu digunakanlah rangkaian driverrelay agar relay inilah yang akan
menyambungkan dan memutuskan tegangan yang dibutuhkan pompa
akuarium, sedangkan untuk mengaktifkan driverrelay dapat menggunakan
output dari mikrokontroler.

Adapun komponen elektronika yang dibutuhkan dalam perancangan

driverrelay adalah seperti yang ditunjukkan pada Tabel 3.2 di bawah ini :
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Tabel 3.2 : Komponen yang dibutuhkan (driverrelay)

No. Nama Komponen Jumlah
1. | SRD-5VDC (Relay) 1 Buah
2. IC 507F280 1 Buah
3. | Resistor 1 kQ 3 Buah
4. | Dioda Zener 1 Buah
5. | Led model chip ¥ Watt 2 Buah
6. | Transistor (2TY) 1 buah
7. | Connector (cabang 3) 2 Buah

Berikut ini adalah Gambar 3.6, yang memperlihatkan skema rangkaian yang

dirancang untuk driverrelay. Dan untuk membuat skema tersebut pada PCB

polos dengan cara seperti metode pembutan AC-DC adaptor yang telah

dijelaskan sebelumnya, yaitu :

1. Mengambarkan skema rangkaian terlebih dahulu menggunakan Software
Eagle.

2. Mencetak pada kertas A4

3. Proses pelarutan dengan FeCls
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BZ

Gambar 3.6 : Skema rangkaian driver relay

e. Proses layout PCB

1.

Membuka aplikasi Eagle 7.5.0. Setelah halaman controlpanel muncul,
lalu mengklik File > New > Board untuk menggambar tata jalur dan
tata letak rangkaian.

Berikut ini adalah Gambar 3.7 yaitu halaman board setelah melakukan

perintah di atas :

[T 1 Boarg - CAEAGLE-T50\projects\exampies\New_Projectiuntitied.brd - EAGLE 7.5.0 Light!
fle fdit Drw View Iools Library Options Window b

elp
@ [k | (o ] [P e

ile Edit D
FR=a !
[

Gambar 3.7 : Halaman board
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Halaman board memiliki beberapa fungsi tools yang dapat digunakan

untuk menggambar PCB vyaitu seperti yang ditunjukkan pada Tabel

3.3 berikut :
Tabel 3.3 : ToolsEAGLEL.ightEdition

Nama Fungsi

Move Memindahkan posisi komponen

Copy Menggandakankomponen

Mirror Membalik komponen pada sumbu berbeda
Rotate Memutar sudut komponen

Group Mengelompokkan bebrapa komponen menjadi

satu bagian

Change Mengubah parameter dalam menggambar PCB

Add Menambah komponen
Replace Mengganti komponen

Name Memberi nama komponen

Value Memberi nilai satuan komponen

Wire Membuat jalur antarkomponen

Text Membuat tulisan pada PCB

Circle Membuat lingkaran

Arc Membuat garis melingkar

Rect Membuat gambar kotak

Via Menggambar lubang komponen

Selanjutnya mengklik Add hingga muncul halaman baru seperti

tampak pada Gambar 3.8 berikut :



Name Description
VMTB60  Bulk Metal® Foil Technolagy, Tubular Axial Lead Resistors, Meets or Excesds MIL-R-39005 Requi...
VMTASS  Bulk Metal® Foil Technology, Tubular Axial Lead Resistors, Meets or Exceeds MIL-R-39005 Requi.
vs2 RESISTOR
RESISTOR

V23 RESISTOR 1
TISDIIL  ELECTROLYTIC CAPACITOR | O o !
TI5D11  ELECTROLYTIC CAPACITOR
TISD10  ELECTROLYTIC CAPACITOR
TISDSL  ELECTROLYTIC CAPACITOR
TISD9  ELECTROLYTIC CAPACITOR
TISDTL  ELECTROLYTIC CAPACITOR
11507 ELECTROLYTIC CAPACITOR.
TISDEL  ELECTROLYTIC CAPACITOR =

TT5D6 ELECTROLYTIC CAPACITOR ELECTROLYTIC CAPACITOR
TI2D7L  ELECTROLYTIC CAPACITOR
207 ELECTROLYTIC CAPACITOR
TT2D6L  ELECTROLYTIC CAPACITOR
TT2D6 ELECTROLYTIC CAPACITOR
TT205L  ELECTROLYTIC CAPACITOR
TI2D5  ELECTROLYTIC CAPACITOR
TT204L  ELECTROLYTIC CAPACITOR
TI2D4  ELECTROLYTIC CAPACITOR
TI8-U2  Inductor

T9-UL  Inductor

diameter 7 mm, grid 5.08 mm

V| pads (7] Smds (¥ pescription | Preview

search B3

ncel
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———

Gambar 3.8 : Memilih jenis komponen

Pada halaman Addterdapat tiga jenis frame sebagai berikut :

- Frame untuk memilih jenis-jenis komponen elektronika. Ada ratusan

jenis komponen yang terdapat pada library EAGLE layout.

- Frame untuk menampilkan gambar komponen yang dipilih.

- Frame ini menampilkan keterangan komponen, berupa nama, tipe,

dan ukuran komponen.

Selanjutnya pilih kategori kapasitor dengan ukuran 5, 6, dan 7 mm,

dan mengklik OK, kemudian meletakkan komponen pada board.

Kategori pin connector dengan mengklik Add >Pinheadl x 3

sebanyak 1 buah.

Selanjutnya adalah proses pembuatan tata jalur rangkaian dengan cara

mengklik Wirehingga muncul opsi baru pada toolbar bagian atas.

Untuk memberi garis tepi rangkaian, dengan mengklik Wire>Layer

Dimension. Selanjutnya membuat lubang spicerdengan menggunakan

toolViadan memilih nilai drill sebesar 3,2 dan meletakkan lubang

spicer di setiap ujung PCB.
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Gambar komponen tidak dibutuhkan saat mencetak tata jalur. Oleh
karena itu, sebelum mencetak tata jalur, menghapus gambar
komponen terlebih dahulu. Caranya, mengklik Display, yaitu
mengklik tanda biru pada nomor 21 dan 22. Secara otomatis, tanda
biru pada nomor 23 sampai 28 akan hilang. Kemudian mengklik OK,
dan tata letak komponen akan hilang.

Mengklik Print, dan memberikan tanda centang pada opsi Black dan
Solid, kemudian mengklik Page. Selanjutnya mencetak tata jalur
sebanyak 3 kali pada kertas yang sama, dengan setting vertikal top-
center-bottom. Hal ini dilakukan untuk membuat cadangan gambar
jika terjadi kesalahan pada proses pembuatan PCB. selanjutnya

mengklik OK.

10. Mencetak jalur PCB pada kertas A4.

f.  Proses Pelarutan PCB dengan Larutan FeCl3

Setelah mencetak tata jalur, tahap selanjutnya adalah melarutkan PCB

dengan langkah-langkah berikut ini :

1.

Memotokopi hasil cetakan tersebut dengan menggunakan Kkertas
transparansi.
Menggunting hasil fotokopi gambar tata jalur sesuai dengan garis tepi
yang dibuat.
Menyiapkan PCB yang telah dibersihkan dengan menggunakan kertas
gosok tipis dan bilasan air. Selanjutnya memanaskan setrika dengan

suhu maksimal.
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Menempelkan gambar tata jalur yang telah digunting, dan memastikan

bagian yang terkena tinta (bagian yang kasar) menempel pada PCB.

Menempelkan setrika panas di atas kertas transparansi, lalu menekan

dan menahan selama 30 detik.

Mendinginkan PCB dengan menggunakan air, dan melepaskan kertas

transparansi dari PCB secara perlahan.

Memotong PCB sesuai dengan garis tepi gambar tata jalur rangkaian.

Melarutkan tembaga pada PCB dengan menggunakan larutan FeCls,

dengan cara :

Menyiapkan wadah plastik dan air panas, dan memasukkan FeCls
secukupnya, kemudian memasukkan PCB pada larutan tersebut.
Menggoyang wadah plastik secara perlahan untuk mempercepat
proses peleburan tembaga pada PCB.

Setelah proses peleburan selesai, selanjutnya mengeluarkan PCB
dari larutan dan membilas dengan air. Selanjutnya menggunakan
kertas gosok untuk membersihkan tinta-tinta yang menempel
pada PCB, hingga jalur-jalur tembaga pada PCB terlihat.
Mengeringkan PCB. Dan selanjutnya proses pengeboran jalur-
jalur rangkaian yang berbentuk lingkaran menggunakan bor listrik
berdiameter 0,8 — 1 mm.

Setelah dibor, tahap terakhir adalah membersihkan PCB dengan

menggunakan kertas gosok dan bilasan air.
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g. Perancangan dan Pembuatan Sensor Infra Merah

Berikut ini adalah Gambar 3.9 yaitu skema rangkaian sensor infra merah

dalam penelitian yang dibuat :

Vce
R1 § R2
220 Q 4600 Q
e N OUTPUT
LED v N
FOTODIODA

GND

Gambar 3.9 : Skema rangkaian sensor infra merah dan fotodioda

h. Rancangan dan Pembuatan Sistem Minimum Arduino Uno
Gambar 3.10 di bawah ini adalah gambar yang menunjukkan skema

rangkaian dari sistem minimum Arduino Uno beserta mikrokontroler

ATMega 328 :
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Gambar 3.10 : Sistem minimum arduino uno

i. Perancangan dan Pembuatan Sistem secara Keseluruhan
Dalam perancangan dan pembuatan sistem secara keseluruhan berarti seluruh
komponen pembentuk sistem kontrol intensitas cahaya lampu akan dilakukan
penggabungan seluruhnya baik dari segi mekanik maupun instalasi listriknya.

Berikut Gambar 3.11 yang menampilkan skema rangkaian seluruh sistem :
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220Q
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220Q
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Gambar 3.11 : Skema rangkaian seluruh sistem

3.3. Pemograman Mikrokontroler ATMega 328
Adapun rincian program bahasa C yang dimasukkan pada sistem Arduino

Uno adalah sebagai berikut :

#define buttonPinUp 6  // pin sensor masuk



#define buttonPinDown 7  // pin sensor keluar
#define relayl 4 // relay 1
#define relay2 2 // relay 1
#define relay3 3 // relay 1

{1111/ Data untuk cek kondisi //////
byte checkMasuk = 0;

int addr = 0;

#include <EEPROM.h>

int addrValue = 0;

int counter = 0;

/11l Data acuan Iv lampu ////
byte Ivl = 1;
byte Iv2 = 2;
byte Iv3 = 3;

void setup() {
11111 dekalarasi pin output ////1]
pinMode(relayl, OUTPUT);
pinMode(relay2, OUTPUT);
pinMode(relay3,0UTPUT);
digitalWrite(relayl,HIGH);
digitalWrite(relay2,HIGH);
digitalWrite(relay3,HIGH);

I deklarasi pin input
pinMode(buttonPinUp,INPUT));
addrValue = EEPROM.read(addr);
if(addrValue !'= 186) checkMasuk = 10;
else checkMasuk = 0;
pinMode(buttonPinDown, INPUT);

}
void loop() {

}

void checkSensor()

checkSensor(); // lompat ke subrutin fungsi checkSensor

switch(checkMasuk_){
case O:
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if(digitalRead(buttonPinUp) == HIGH) checkMasuk_ = 1; //baca sensor masuk
else if(digitalRead(buttonPinDown) == HIGH) checkMasuk_ = 4; //baca sensor

keluar
else checkMasuk = 0;
break;
case 1:
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if(digitalRead(buttonPinUp) == LOW) checkMasuk_ = 2; //baca sensor masuk

else checkMasuk_ = 1;
break;
case 2:
if(digitalRead(buttonPinDown) == HIGH) checkMasuk_ = 3; //baca sensor

keluar
else checkMasuk_ = 2;
break;

case 3:
if(digitalRead(buttonPinDown) == LOW) //baca sensor keluar

counter++; // counter = counter +1
checkLv(); // check relay
delay(100); // delay

checkMasuk = 0; // reset data

else checkMasuk_ = 3;
break;

case 4:
if(digitalRead(buttonPinDown) == HIGH) checkMasuk_ = 5; //baca sensor
kelaur
else checkMasuk_ = 4;
break;
case 5:
if(digitalRead(buttonPinDown) == LOW) checkMasuk_
keluar
else checkMasuk_ = 5;
break;
case 6:
if(digitalRead(buttonPinUp) == HIGH) checkMasuk
masuk
else checkMasuk = 6;
break;
case 7:
if(digitalRead(buttonPinUp) == LOW) ////baca sensor masuk
{
if(counter <=0) counter = 0;
else counter--; // counter = counter - 1
checkLv(); // check relay
delay(100); // delay
checkMasuk__ = 0; // reset data
¥
else checkMasuk = 7;
break;
}
}
I fungsi check level aksi terhadap relay///

6; ////baca sensor

7: [/baca sensor
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void checkLv(){
if(counter >=lv3)

digitalWrite(relay3,LOW);

}

else if(counter >=Iv2)

{
digitalWrite(relay2,LOW);
digitalWrite(relay3,HIGH);

¥

else if(counter >= Iv1)

{
digitalWrite(relayl,LOW);
digitalWrite(relay2,HIGH);
digitalWrite(relay3,HIGH);

¥

else

{
digitalWrite(relayl,HIGH);
digitalWrite(relay2,HIGH);
digitalWrite(relay3,HIGH);

¥

¥

Gambar 3.12 berikut ini adalah gambar yang menampilkan model layar

jendela aplikasi untuk menuliskan program bahasa “C” di atas.

£ Dimmer_Counter_Room3 | Ardun

File Edit Sketch Tools Help

Gambar 3.12 : Jendela aplikasi penulisan program
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3.4. Flowchart Sistem Kerja Alat
Berikut adalah Gambar 3.13 yang memperlihatkan alur kerja sistem

kontrol intensitas penerangan pada ruang baca:

Seluruh Sistem Aktif

v

Cek
Sensor Infra Red

Tida
2 Orang Masuk

2 Orang Tinggal
dalam Ruangan
dari > 2 Orang Masul

Lampu 1 Menyala

Lampu 2 Menyala

Lampu 3 Menyala

3 Lampu
Tetap Menyala

Tidak

Lampu 3 Mati

Tidak

1 Orang Tinggal
dalam Ruangan
dari > 1 Orang Masu

Lampu 2 Mati

Tidak

“0" Orang Tinggal
dalam Ruangan
dari > 0 Orang Masu

Lampu 1 Mati

4
Selesai

Gambar 3.13 : Flowchart sistem kerja alat



BAB IV

HASIL DAN PEMBAHASAN

4.1. Hasil Perancangan dan Pembuatan Alat

Dari hasil penelitian yang dilakukan, dihasilkan suatu sistem kontrol
intensitas kuat penerangan lampu pada ruang baca berbasis mikrokontroler
ATMega 328 sistem minimum Arduino Uno sperti terlihat pada Gambar 4.1

berikut :

m | ' 1 i y wnmmnlnulu m “'
e

Gambar 4.1 :
Sistem kontrol penerangan lampu pada ruang baca
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4.2. Hasil Pengujian Alat

Setelah alat yang dirancang dan dibuat sesuai konsep penelitian ini selesai

dilakukan maka tahap selanjutnya melakukan pengujian alat secara keseluruhan,

dimana kriterian pengujian adalah sebagai berikut :

1.

2.

Pengujian kondisi lampu terhadap jumlah orang yang masuk pada ruang baca.
Pengujian kondisi lampu terhadap jumlah orang yang keluar dari ruang baca.
Pengujian kondisi lux cahaya lampu terhadap jarak dari alat ukur lux meter
jika satu lampu yang hidup.

Pengujian kondisi lux cahaya lampu terhadap jarak dari alat ukur lux meter
jika dua lampu yang hidup.

Pengujian kondisi lux cahaya lampu terhadap jarak dari alat ukur lux meter

jika tiga lampu yang hidup.

4.2.1 Hasil Pengujian Kondisi Lampu terhadap Jumlah Orang Masuk

Berikut adalah Tabel 4.1, yang menampilkan hasil pengujian kondisi

lampu terhadap jumlah orang yang masuk:

Tabel4.1 :Hasilpengujiankondisi lampu terhadap jumlah orang masuk

Jumlah Kondisi Kondisi Kondisi
Orang Masuk Lampu (1) Lampu (I1) Lampu (111)

0 Mati Mati Mati
1 Hidup Mati Mati
2 Hidup Hidup Mati
3 Hidup Hidup Hidup
4 Hidup Hidup Hidup
5 Hidup Hidup Hidup
6 Hidup Hidup Hidup
7 Hidup Hidup Hidup
8 Hidup Hidup Hidup
9 Hidup Hidup Hidup
10 Hidup Hidup Hidup
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Dari Tabel 4.1 di atas dapat dilihat bahwa lampu akan menyala secara
berturut, yaitu jika tidak ada orang di dalam ruangan maka lampu dalam
kondisi awal yaitu semua lampu kondisi mati. Dan ketika masuk satu
orang maka lampu (1) hidup dengan nyala yang terang dan ketika orang
kedua memasuki ruang baca sehingga jumlah orang yang di dalam
ruang baca menjadi dua orang maka lampu (Il) hidup dengan nyala
terang sehingga total jumlah lampu yang hidup adalah dua buah.

Selanjutnya ketika orang ketika memasuki ruang baca dan total jumlah
orang yang ada di dalam ruang baca menjadi tiga orang maka lampu
(1) hidup dengan nyala terang sehingga total jumlah lampu yang hidup
adalah tiga buah. Selanjutnya untuk orang keempat, kelima dan
seterusnya ketika memasuki ruang baca, kondisi lampu tetap menyala

terang.

4.2.2 Hasil Pengujian Kondisi Lampu terhadap Jumlah Orang Keluar
Berikut ini adalah Tabel 4.2, yang menampilkan hasil pengujian kondisi

lampu terhadap jumlah orang yang keluar :

Tabel4.2 :Hasil pengujian kondisi lampu terhadap jumlah orang keluar

Jumlah Kondisi Kondisi Kondisi
Orang Keluar Lampu (1) Lampu (1) | Lampu (1)

0 Tinggal 10 Orang Hidup Hidup Hidup
1 Tinggal 9 Orang Hidup Hidup Hidup
2 Tinggal 8 Orang Hidup Hidup Hidup
3 Tinggal 7 Orang Hidup Hidup Hidup
4 Tinggal 6 Orang Hidup Hidup Hidup
5 Tinggal 5 Orang Hidup Hidup Hidup
6 Tinggal 4 Orang Hidup Hidup Hidup
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7 Tinggal 3 Orang Hidup Hidup Hidup
8 Tinggal 2 Orang Hidup Hidup Mati
9 Tinggal 1 Orang Hidup Mati Mati
10 Tinggal 0 Orang Mati Mati Mati

Dari Tabel 4.2 di atas dapat dilihat bahwa lampu akan mati secara
berturut, yaitu jika tidak ada orang di dalam ruangan maka lampu akan
kembali dalam kondisi awal yaitu semua lampu kondisi mati. Dan
ketika keluar 8 orang dari 10 orang maka lampu (I11) mati dan ketika 9
orang keluar dari 10 yang ada di dalam ruang baca maka lampu (1)
mati. Selanjutnya ketika 10 orang total jumlah yang keluar maka lampu

(1) mati sehingga total jumlah lampu ketiganya mati.

4.2.3 Pengujian Kondisi Lux Cahaya Lampu terhadap Jarak (Satu Lampu)
Berikut ini adalah Tabel 4.3 yang menampilkan hasil pengujiankondisi
lux cahaya lampu terhadap jarak dari alat ukur lux meter jika satu

lampu yang hidup :

Tabel 4.3 : Hasil pengujian lux 1 lampu terhadap jarak

1. 40 cm 100 Lux
2. 20cm 200 Lux
3. 15cm 300 Lux

4, 13cm 400 Lux
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S. 10 cm 500 Lux
6. 9cm 600 Lux
7. 8cm 700 Lux
8. 7cm 800 Lux
9. 6 cm 900 Lux
10. 5cm 1000 Lux

Dari Tabel 4.3 di atas dapat dilihat bahwa kondisi lux meter yang
terbaca terhadap kuantitas cahaya lux dari satu lampu pijar yang hidup
dengan spesifikasi lampu pijar 5 Watt adalah semakin dekat jarak lux
meter dengan lampu pijar maka kuantitas lux cahaya lampu semakin
besar, dan sebaliknya jika jarak lux meter dengan lampu pijar semakin

jauh maka kuantitas lux cahaya lampu semakin kecil.

4.2.4 Pengujian Kondisi Lux Cahaya Lampu terhadap Jarak (Dua Lampu)
Berikut ini adalah Tabel 4.4 yang menampilkan hasil pengujiankondisi
lux cahaya lampu terhadap jarak dari alat ukur lux meter jika dua lampu

yang hidup :
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Tabel 4.4 : Hasil pengujian lux 2 lampu terhadap jarak

1. 70 cm 100 Lux
2. 30cm 200 Lux
3. 24 cm 300 Lux
4. 22 cm 400 Lux
5. 19 cm 500 Lux
6. 17 cm 600 Lux
7. 16 cm 700 Lux
8. 15cm 800 Lux
9. 14 cm 900 Lux
10. 13 cm 1000 Lux

Dari Tabel 4.4 di atas dapat dilihat bahwa kondisi lux meter yang
terbaca terhadap kuantitas cahaya lux dari dua lampu pijar yang hidup
dengan spesifikasi lampu pijar masing — masing 5 Watt adalah dimana
semakin dekat jarak lux meter dengan kedua lampu pijar maka
kuantitas lux cahaya lampu semakin besar, dan sebaliknya jika jarak lux
meter dengan kedua lampu pijar semakin jauh maka kuantitas lux
cahaya lampu semakin kecil.

Dalam hasil pengujian di atas dapat dilihat bahwa perbedaannya dengan
pengujian untuk satu lampu yaitu jarak antara lux meter dengan lampu
lebih jauh dibandingkan dengan yang satu lampu dimana kuantitas lux

yang dihasilkan adalah sama.
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4.2.5 Pengujian Kondisi Lux Cahaya Lampu terhadap Jarak (Tiga Lampu)
Berikut ini adalah Tabel 4.5 yang menampilkan hasil pengujiankondisi
lux cahaya lampu terhadap jarak dari alat ukur lux meter jika tiga lampu
yang hidup :

Tabel 4.5 : Hasil pengujian lux 3 lampu terhadap jarak

1. 90 cm 100 Lux
2. 50 cm 200 Lux
3. 45 cm 300 Lux
4. 40 cm 400 Lux
5. 35cm 500 Lux
6. 33cm 600 Lux
7. 32cm 700 Lux
8. 3l1cm 800 Lux
9. 30cm 900 Lux
10. 29 cm 1000 Lux

Dari Tabel 4.5 di atas dapat dilihat bahwa kondisi lux meter yang
terbaca terhadap kuantitas cahaya lux dari tiga lampu pijar yang hidup
dengan spesifikasi lampu pijar masing — masing 5 Watt adalah dimana
semakin dekat jarak lux meter dengan ketiga lampu pijar maka
kuantitas lux cahaya lampu semakin besar, dan sebaliknya jika jarak lux
meter dengan ketiga lampu pijar semakin jauh maka kuantitas lux

cahaya lampu semakin kecil.



64

Dalam hasil pengujian di atas dapat dilihat perbedaannya yaitu lebih
jauh jaraknya antara lux meter dengan lampu dengan kuantitas lux yang
sama dibandingan dengan jarak untuk satu lampu dan dua lampu yang

hidup.

4.2.6 Hasil Pengujian Kondisi Lampu Pijar
Dalam pengujian kondisi lampu pijar cukup simpel karena hanya
menghubungkan fittingnya bersama lampu pijar didalamnya dengan aliran
listrik PLN 220 VAC.
Ternyata setelah diuji maka hasil pengujian lampu pijar dapat dilihat seperti

pada Tabel 4.6 berikut ini :

Tabel4.6 :Hasil pengujian lampu pijar

Pengujian Aliran Listrik 220VAC Kondisi Lampu

I Terhubung Hidup
] Tidak Terhubung Mati




BAB V

KESIMPULAN DAN SARAN

5.1. Kesimpulan

Dari hasil penelitian yang dilakukan maka dapat diambil kesimpulan

sebagai berikut :

1.

5.2.

Sistem kontrol intensitas kuat penerangan lampu pijar mampu memenuhi
syarat dari tujuan penelitian dengan indikator intensitas penerangan lampu
pijar dapat dikendalikan sesuai jumlah orang yang masuk dalam ruang baca.
Tingkat ketelitian pendeteksian sensor infra red mampu memenuhi syarat
dengan mendeteksi jumlah orang yang masuk pada ruang baca dengan
mengontrol 3 buah lampu.

Dengan sistem pengendali 1C mikrokontroler ATMega 328 dapat melakukan
proses pembacaan data dengan adanya orang yang masuk dan kluar dari

ruang baca.

Saran

Adapun yang menjadi saran pada penelitian ini adalah :

Untuk kesempurnaan alat ini kedepannya alangkah baiknya sistem rancangan
alat dapat diimplementasikan secara langsung di lapangan dengan
mencocokkan nilai intensitas penerangan dengan standart yang ada.

Alat ini bekerja baru sebatas dapat mengendalikan secara otomatis intensitas

penerangan melalui jumlah lampu pijar yang mesti hidup pada ruang baca.
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3. Jika ingin mencocokkan nilai standart intensitas yang ada terhadap cahaya
yang dikeluarkan oleh lampu pijar maka cukup mengganti lampunya saja

dengan lampu pijar yang nilai Watt-nya lebih besar sesuai standart.
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Lampiran 1 : Sistem kontrol intensitas penerangan tampak depan dan tampak belakang

Dari hasil penelitian yang dilakukan, dihasilkan suatu sistem kontrol intensitas
kuat penerangan lampu pada ruang baca berbasis mikrokontroler ATMega 328

sistem minimum Arduino Uno sperti terlihat pada Gambar di atas.

69



70

Lampiran 4 : Lux meter tampak depan dan tampak atas

Lux meter adalah alat yang digunakan untuk mengukur besarnya intensitas
cahaya di suatu tempat. Besarnya intensitas cahaya ini perlu untuk diketahui
karena pada dasarnya manusia juga memerlukan penerangan yang cukup.
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ABSTRAK

Telah dilaksanakan pembuatan sistem pengontrol cahaya untuk mengontrol Kkuat
penerangan cahaya lampu pijar pada ruang baca berdasarkan jumlah orang yang masuk
pada ruang baca. Sistem ini dibangun menggunakan sensor infra red sebagai pendeteksi
orang masuk dan kluar dari ruang baca. Arduino uno sebagai sistem pengendali seluruh
sistem yang dibuat. Pengujian dilakukan dengan beberapa tahap antara lain hubungan
kondisi lampu terhadap jumlah orang yang masuk dan Kkluar dari ruang baca serta
pengujian hubungan antar kuantitas lux cahaya lampu pijar terhadap jarak. Hasil
penelitian ini menunjukan bahwa sistem dapat mengontrol dan menjaga kesatabilan
intensitas cahaya ruang baca berdasarkan jumlah orang dan yang kluar dari ruang baca.
Kata kunci: Sensor, Intensitas Cahaya, mikrokontroler ATMega328 Arduino uno.

ABTRACT

Has made the manufacture of light control system to control the powerful illumination
incandescent light bulbs in the reading room based on the number or people entering the
reading room. The system is built using infra red sensor as a detector of people in and out
of the den. Arduiniuno as control systems throughout the system are made. Testing is
done by several stages include light conditions relation to the number of people in end out
of the reading room as well as testing the relationship between the quantity of lux
incandescent light bulbs to the distance. The results of this study indicate that the system
can control and maintain stable ligth intensity based on the number of people reading
room and coming out of the den.

Keywords: Sensor, Ligth Intensity, Arduino uno ATMega328 microcontroller.

PENDAHULUAN

Latar Belakang

Membaca merupakan salah satu
aktivitas yang memerlukan cahaya. Penerangan
cahaya yang direkomendasikan dalam aktivitas
membaca yaitu 250 Lux (SNI No. 16-7062-
2004). Berdasarkan penelitian yang telah
dilakukan Fathimahhayati (2012) dan Nursalim
dkk (2012) menyatakan bahwa sebagian besar
intensitas penerangan cahaya pada ruang tempat
berlangsung aktivitas membaca tidak sesuai
SNI (Standar Nasional Indonesia). Intensitas

cahaya yang tidak sesuai standar dalam proses
membaca dapat menjadi salah satu penyebab
kerusakan organ penglihatan.

Berangkat dari masalah di atas saya
mencoba mencari solusi bagaimana agar dapat
menyesuaikan standart intensitas penerangan
yang cocok untuk ruang baca agar manusia
didalamnya tidak mengalami kerusakan organ
penglihatannya dengan mengangkat sebuah judul
penelitian yang tidak lepas dari masalah tersebut
yaitu “Rancang Bangun Penerangan Listri Pada
Ruang Baca Menggunakan Sensor Manusia.
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Perumusan Masalah
Adapun yang menjadi rumusan
masalah dalam penelitian ini adalah :

1. Bagaimana merancang dan membuat
sistem pengaturan penerangan lampu
secara otomatis pada ruang baca?

2. Bagaimana mengontrol intensitas cahaya
lampu agar intensitas penerangan pada
ruang baca sesuai lingkungan sekitar?

3. Variabel apa yang dideteksi agar lampu
mengeluarkan penerangan yang sesuai
pada ruangan baca?

Batasan Masalah
Yang menjadi batasan masalah dalam
penelitian ini adalah :

1. Penelitian yang dilakukan berbentuk
studi rancang bangun alat yang seluruh
komponen  pembentuknya  dijelaskan
secara mendetail dan ilmiah dalam
laporan ini.

2. Ruang lingkup pembahasan meliputi
perangkat hardware dan software.

3. Alat yang dirancang dan dibuat adalah
dalam skala kecil yaitu hanya mengontrol
tiga buah lampu.

Tujuan Penelitian
Tujuan dari penelitian ini adalah :

1. Mampu merancang suatu sistem kontrol
penerangan lampu pada ruang baca secara
hardware dan software dan dalam bentuk
skala kecil dengan menggunakan sebuah
pengendali cerdas yaitu sistem Arduino Uno.

2. Dapat  mengimplementasikan  sebuah
sensor agar penerangan cahaya lampu yang
dikeluarkan sesuai yang dibutuhkan pada
ruang baca.

3. Mampu mendeteksi jumlah orang yang
masuk dan yang keluar pada ruang baca
agar dapat mengatur penerangan cahaya
lampu yang harus dikeluarakan.

Manfaat Penelitian
Dari penelitian ini diharapkan dapat
memberikan manfaat sebagai berikut :

1. Bagi pengguna, dapat memudahkan pengguna
untuk mengontrol saklar listrik walaupun
berada jauh dari area peralatan yang akan
dikontrol sehingga meningkatkan efisiensi
waktu aktifitas pengguna, menghilangkan rasa

kekhawatiran pengguna saat meninggalkan
ruang baca tersebut yang kosong.

2. Bagi perkembangan IPTEK, sebagai bahan
masukan  dalam rangka  menciptakan
peralatan guna menghemat energi listrik.

3. Bagi penulis, sebagai bahan pembelajaran
dalam bidang perancangan sistem operasi
aplikasi pengontrolan intensitas cahaya
berbasis mikrokontroler.

Sistematika Pembahasan

Sistematika penulisan Tugas Akhir ini
adalah sebagai berikut:
BAB | PENDAHULUAN
Berisi latar belakang, perumusan masalah
yang diteliti, tujuan dan manfaat penelitian,
pembatasan masalah yang diteliti, serta
sistematika penulisan laporan.
BAB Il TINJAUAN PUSTAKA
Berisi tentang cakupan konsep dan teori-teori
pendukung yang menjadi landasan
penyusunan tugas akhir.
BAB Il METODOLOGI PENELITIAN
Berisi tentang bagaimana metode penelitian
dilakukan, yang meliputi bagaimana cara
pengambilan data, cara perancangan dan
pembuatan alat serta pengujiannya.
BAB IV HASIL DAN PEMBAHASAN
Berisi tentang hasil dari segala bentuk
pengujian alat yang dilakukan serta hasil yang
didapatkan akan dilakukan pembahasan
secara mendetail.
BAB VI PENUTUP
Berisi tentang kesimpulan dan saran yang
didapatkan dari penelitian yang dilakukan.

TINJAUAN PUSTAKA

Tinjauan Pustaka Relevan

Telah  dilakukan  rancang-bangun
sistem otomatisasi kontrol lampu berdasarkan
keberadaan orang didalam ruangan. Sistem
kontrol lampu akan menyala selama ada
orang didalam ruangan, dan lampu akan mati
ketika orang meninggalkan  ruangan.
Keberadaan orang akan di deteksi oleh sensor
passive infrared (PIR). Jarak waktu respon
dari sensor PIR KC7783R telah dicobakan,
dimana sensor hanya dapat mendetekasi
objek selama 5,37 detik, namun dapat diatasi
dengan  menggunakan  program  yang
ditanamkan ke dalam  mikrokontroler
AT89S51. Jarak maksimum yang dapat di



deteksi sensor PIR adalah 4,3 meter pada
sudut 0° (lurus dari depan sensor), dan 2
meter pada sudut 30° (kekiri dan kekanan).
Sensor membutuhkan waktu pemanasan
selama 25,52 detik. Relay digunakankan
untuk menghubungkan antara arus dc dan
arus ac.(Wildian 2013)

Telah dilakukan pembuatan sistem
pengontrol cahaya untuk mengontrol kuat
penerangan cahaya pada ruang baca. Sistem
ini dibangun menggunakan sensor Light
Dependent  Resistor  (LDR)  sebagai
pendeteksi intensitas cahaya. Tegangan
analog LDR diolah oleh mikrokontroler
ATMegal6 untuk mengontrol tiga buah
lampu sebagai sumber penerangan ruang
baca. Pengujian dilakukan dengan
membandingkan hasil pengukuran intensitas
cahaya alat hasil rancangan denganalat
standar. Hasil penelitian ini menunjukkan
bahwa sistem dapat mengontrol dan menjaga
kestabilan intensitas cahaya ruang baca dalam
rentang 300—-400Lux.(Nurhasanah 2015)

Keamanan gedung dan rumah mewah
sangat diperlukan untuk mengatasi tindak
kejahatan seperti pencurian dan perampokan.
Untuk pengamanan gedung dan rumah
mewah diperlukan sebuah sistem pengamanan
yang dapat diaplikasikan atau digunakan oleh
suatu perusahaan. Salah satunya adalah sistem
keamanan dengan menggunakan sensor
Passive Infra Red (PIR) KC7783R dan
mikrokontroler ATmega8535 yang sudah di
dukung dengan bahasa pemograman C.
Sistem keamanan gedung dan rumah mewah
diantaranya menggunakan kamera CCTV
yang dipantau oleh operator yang diminta
oleh pemilik gedung atau rumah mewah
tersebut. Kamera CCTV ada yang
menggunakan sensor IR dan ultrasonik, tetapi
dalam penggunaannya juga dibutuhkan
sumber sensor lain. Contohnya, sensor
otomatis yaitu PIR sensor dengan jangkauan
yang cukup panjang.(Zain 2013)

Saklar Otomatis

Penggunaan saklar otomatis di ruang
baca merupakan salah satu cara operasi yang
digunakan untuk mengendalikan beban listrik.
Ide penggunaan saklar otomatis ini muncul
sebagai upaya menghindari pemborosan

energi listrik. Selain itu juga saklar otomatis
dapat memudahkan operasi.

Dari segi ekonomis, dengan memasang
saklar otomatis, maka keborosan energi listrik
dapat dihindari. Dan penggunaan energi listrik
pun menjadi terkontrol.

Smart Building

Perkembangan  teknologi  melaju
dengan sangat pesat. Perkembangan teknologi
ini merupakan hasil kerja keras dari rasa ingin
tahu manusia terhadap suatu hal yang pada
akhirnya diharapkan akan mempermudah
kehidupan manusia. Salah satu cara untuk
mempermudah kehidupan manusia adalah
dengan membangun smart building.

Smart building sudah menjadi salah
satu topik pembahasan dalam karyatulis fiksi
ilmiah selama bertahun-tahun, namun baru
mulai dicoba untuk diwujudkan pada awal
abad ke 20 ketika pemakaian energi listrik
telah meluas hingga ke rumah-rumah dan
mulai majunya teknologi informasi.

Smart  building mengacu pada
penggunaan  teknologi  informasi  dan
komputer untuk mengendalikan peralatan
yang berada di dalam bangunan tersebut
(seperti jedela atau lampu). Sistem yang
beropersi dalam smartbuilding dapat berupa
sistem kontrol jarak jauh yang sederhana dari
lampu-lampu hingga sebuah sistem yang
berbasis komputer atau mikrokontroler yang
memiliki tingkat kecerdasan yang bervariasi
yang secara otomatis mengontrol peralatan
yang berada di dalam bangunan.

Elemen dalam sebuah sistem smart
building terdiri dari sensor (seperti sensor
cahaya atau sensor suhu), pengontrol (seperti
komputer atau mikrokontroler) dan aktuator
(seperti motor, relay, servo atau sakelar
lampu). Sebuah antarmuka antara manusia
dengan mesin diperlukan, agar pemilik
bangunan dapat berinteraksi dengan sistem
untuk memonitor atau mengontrolnya.

Antarmuka ini dapat berupa terminal
khusus atau aplikasi yang berjalan pada
telepon genggam atau komputer tablet.
Antarmuka tersebut berkomunikasi dengan
sitem melalui jaringan kabel atau wireless
menggunakan satu atau lebih protokol.



Arduino

Arduino adalah platform pembuatan
prototipe elektronik yang bersifat open-source
hardware yang berdasarkan pada perangkat
keras dan perangkat lunak yang fleksibel dan
mudah digunakan. Arduino ditujukan bagi
para seniman, desainer, dan siapapun yang
tertarik dalam menciptakan objek atau
lingkungan yang interaktif.

Arduino Development Environment
adalah perangkat lunak yang digunakan untuk
menulis dan meng-compile program untuk
arduino. ArduinoDevelopment Environment
juga digunakan untuk meng-upload program
yangsudah di-compile ke memori program
arduino board.

Arduino Uno
Arduino Uno adalah arduino board yang
menggunakan  mikrokontroler ~ ATmega328.
Arduino Uno memiliki 14 pin digital (6 pin dapat
digunakan sebagai output PWM), 6 input analog,
sebuah 16 MHz osilator kristal, sebuah koneksi
USB, sebuah konektor sumber tegangan, sebuah
header ICSP, dan sebuah tombol reset. Arduino
Uno memuat segala hal yang dibutuhkan untuk
mendukung sebuah mikrokontroler. Hanya
dengan menhubungkannya ke sebuah komputer
melalui USB atau memberikan tegangan DC dari
baterai atau adaptor AC ke DC sudah dapat
membuanya bekerja. Arduino Uno
menggunakan ATmegal6U2 yang diprogram
sebagai  USB-to-serial ~ converter  untuk
komunikasi serial ke computer melalui port
USB. Tampak atas dari arduino uno dapat dilihat
pada Gambar 2.2.
Adapun data teknis board Arduino
Uno R3 adalah sebagai berikut:
13. Mikrokontroler : ATmega328
14, Tegangan Operasi : 5V
15.  Tegangan Input (recommended) : 7 -
12V
16.  Tegangan Input (limit) : 6-20 V
17. Pin digital 1/0 : 14 (6 diantaranya pin
PWM)
18. Pin Analog input : 6
19.  Arus DC per pin 1/0 : 40 mA
20.  Arus DC untuk pin 3.3 V : 150 mA
21. Flash Memory : 32 KB dengan 0.5 KB
digunakan untuk bootloader
22. SRAM: 2 KB
23. EEPROM : 1 KB

24. Kecepatan Pewaktuan : 16 Mhz

Gamar 2.1: Aruino uno

Pin Masukan dan Keluaran Arduino Uno
Masing-masing dari 14 pin digital

arduino uno dapat digunakan sebagai
masukan atau keluaran menggunakan fungsi
pinMode(), digitalWrite() dan digitalRead().
Setiap pin beroperasi pada tegangan 5 volt.
Setiap pin  mampu  menerima  atau
menghasilkan arus maksimum sebasar 40 mA
dan memiliki resistor pull-up internal (diputus
secara default) sebesar 20-30 KOhm. Sebagai
tambahan, beberapa pin masukan digital
memiliki kegunaan khusus yaitu:

6. Komunikasi serial: pin 0 (RX) dan pin 1
(TX), digunakan untuk menerima(RX) dan
mengirim(TX) data secara serial.

7. External Interrupt: pin 2 dan pin 3, pin ini
dapat dikonfigurasi untuk memicu sebuah
interrupt pada nilai rendah, sisi naik atau
turun, atau pada saat terjadi perubahan
nilai.

8. Pulse-width  modulation (PWM): pin
3,5,6,9,10 dan 11, menyediakan keluaran
PWM 8-bit dangan menggunakan fungsi
analogWrite().

9. Serial Peripheral Interface (SPI): pin 10
(SS), 11 (MOSI), 12 (MISO) dan 13
(SCK), pin ini mendukung komunikasi SPI
dengan menggunakan SPI library.

10.LED: pin 13, terdapat built-in LED yang
terhubung ke pin digital 13. Ketika pin bernilai
HIGH maka LED menyala, sebaliknya ketika
pin bernilai LOW maka LED akan padam.

Arduino Uno memiliki 6 masukan
analog yang diberi label A0 sampai A5, setiap
pin menyediakan resolusi sebanyak 10 bit

(1024 nilai yang berbeda). Secara default pin

mengukur nilai tegangan dari ground (0V)

hingga 5V, walaupun begitu dimungkinkan
untuk mengganti nilai batas atas dengan
menggunakan pin AREF dan fungsi analog

Reference(). Sebagai tambahan beberapa pin

masukan analog memiliki fungsi khusus yaitu

pin A4 (SDA) dan pin A5 (SCL) yang
digunakan untuk komunikasi Two Wire

Interface (TWI) atau Inter IntegratedCircuit

(12C) dengan menggunakan Wire library.



Sumber Daya dan Pin Tegangan Arduino Uno

Arduino uno dapat diberi daya melalui
koneksi USB (Universal Serial Bus) atau
melalui power supply eksternal. Jika arduino
uno dihubungkan ke kedua sumber daya
tersebut secara bersamaan maka arduino uno
akan memilih salah satu sumber daya secara
otomatis untuk digunakan. Power supplay
external (yang bukan melalui USB) dapat
berasal dari adaptor AC ke DC atau baterai.
Adaptor dapat dihubungkan ke soket power
pada arduino uno. Jika menggunakan baterai,
ujung kabel yang dibubungkan ke baterai
dimasukkan kedalam pin GND dan Vin yang
berada pada konektor Power.

Arduino uno dapat beroperasi pada
tegangan 6 sampai 20 Volt. Jika arduino uno
diberi tegangan di bawah 7 Volt, maka pin 5V
akan menyediakan tegangan di bawah 5 Volt
dan arduino uno munkin bekerja tidak stabil.
Jika diberikan tegangan melebihi 12 Volt,
penstabil tegangan kemungkinan akan menjadi
terlalu panas dan merusak arduino uno.
Tegangan rekomendasi yang diberikan ke
arduino uno berkisar antara 7 sampai 12 Volt.

Pin-pin tegangan pada arduino uno
adalah sebagai berikut:

5. Vin adalah pin untuk mengalirkan sumber
tegangan ke arduino uno  ketika
menggunakan sumber daya eksternal
(selain dari koneksi USB atau sumber daya
yang teregulasi lainnya). Sumber tegangan
juga dapat disediakan melalui pin ini jika
sumber daya yang digunakan untuk
arduino uno dialirkan melalui soket power.

6. 5V adalah pin yang menyediakan tegangan
teregulasi sebesar 5 Volt berasal dari
regulator tegangan pada arduino uno.

7. 3V3 adalah pin yang meyediakan tegangan
teregulasi sebesar 3,3 Volt berasal dari
regulator tegangan pada arduino uno.

8. GND adalah pin ground.

Peta Memori Arduino Uno

Arduino Uno adalah arduino board
yang menggunakan mikrokontroler
ATmega328. Maka peta memori arduino uno
sama  dengan peta  memori pada
mikrokontroler ATmega328.

Memori Program
ATMega328 memiliki 32K byte On-

chip In-System Reprogrammable Flash
Memory untuk menyimpan program. Memori
flash dibagi kedalam duabagian, yaitu bagian
program bootloader dan aplikasi seperti
terlihat pada Gambar 2.3. Bootloader adalah
program kecil yang bekerja pada saat sistem
dimulai yang dapat memasukkan seluruh
program aplikasi ke dalam memori prosesor.

Gambar 2.2 ; Peta memori program ATMega 328

Memori Data

Memori data ATMega328 terbagi
menjadi 4 bagian, yaitu 32 lokasi untuk
register umum, 64 lokasi untuk register 1/0O,
160 lokasi untuk register 1/0 tambahan dan
sisanya 2048 lokasi untuk data SRAM
internal. Register umum menempati alamat
data terbawah, yaitu 0x0000 sampai Ox001F.
Register 1/0 menempati 64 alamat berikutnya
mulai dari 0x0020 hingga Ox005F. Register
I/O tambahan menempati 160 alamat
berikutnya mulai dari 0x0060 hingga OxO0FF.
Sisa alamat berikutnya mulai dari 0x0100
hingga Ox08FF digunakan untuk SRAM
internal. Peta memori data dari ATMega 328
dapat dilihat pada Gambar 2.4.
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Gambar 2.3 : Peta memori data atmega 328
Arduino Ethernet Shield

Ethernet Shield menambah
kemampuan arduino board agar terhubung ke
jaringan komputer. Ethernet  shield
berbasiskan cip ethernet Wiznet W5100.
Ethernet library digunakan dalam menulis
program agar arduino board dapat terhubung
ke jaringan dengan menggunakan arduino
ethernet shield.

Pada ethernet shield terdapat sebuah
slot micro-SD, yang dapat digunakan untuk
menyimpan file yang dapat diakses melalui
jaringan. Onboard micro-SD card reader
diakses dengan menggunakan SD library.




Gambar 2.4 : Ethernetshield

Struktur

Setiap program dalam arduino board

terdiri dari dua fungsi utama yaitu setup() dan
loop(). Instruksi yang berada dalam fungsi
setup() dieksekusi hanya sekali, yaitu ketika
arduino board pertama kali dihidupkan.
Biasanya instuksi yang berada pada fungsi
setup() merupakan konfigurasi dan inisialisasi
dari arduino board. Instruksi yang berada
pada fungsi loop() dieksekusi berulang-ulang
hingga arduino board dimatikan (catu daya
diputus). Fungsi loop() merupakan tugas
utama dari arduino board. Jadi setiap program
yang menggunakan bahasa pemrograman
arduino memilliki struktur sebagai berikut:

Konstanta

Konstanta adalah variable yang sudah
ditetapkan  sebelumnya dalam  bahasa
pemrograman arduino. Konstanta digunakan
agar program lebih mudahuntuk dibaca dan

dimengerti. Konstanta dibagi menjadi 3

kelompok yaitu:

1. Konstanta yang  digunakan  untuk
menunjukkan tingkat logika (konstanta
Boolean), yaitu true dan false

2. Konstanta untuk menunjukkan keadaan
pin, yaitu HIGH dan LOW

3. Konstanta untuk menunjukkan fungsi pin,
yaitu INPUT, [INPUT_PULLUP dan
OUTPUT

Konstanta yang digunakan untuk
menunjukkan benar atau salah dalam bahasa
pemrograman arduino adalah true dan false.

False lebih mudah didefinisikan daripada

true. False didefinisikan sebagai O(nol). True

sering didefinisikan sebagai 1(satu), yang
mana hal ini benar, tetapi true memiliki
definisi yang lebih luas. Setiap integer yang
bukan nol adalah true dalam pengertian

Boolean. Jadi -2, 3 dan -100 semuanya

didefinisikan sebagai true, juga dalam

pengertian Boolean. Tidak seperti konstanta
yang lain true dan false diketik dengan
menggunakan huruf kecil.

Fungsi Masukan dan Keluaran Digital

Arduino memiliki 3 fungsi untuk
masukan dan keluaran digital pada arduino
board, yaitu pinMode(), digitalWrite() dan
digitalRead().

Progmem

Terkadang program dibuat
memerlukan memori yang lebih  besar,
misalnya kita perlu menyimpan banyak teks
dalam sebuah program penampil LCD. Hal ini
bisa kita atasi dengan menyimpan data pada
flash memori (memori program). Besar memori
program pada arduino uno adalah 32 KByte.

Kata kunci PROGMEM adalah sebuah
variable modifier,P ROGMEM hanya bisa
digunakan untuk tipe data yang di definisikan
pada library pgmspace.h. PROGMEM
menjelaskan  pada  kompiler  “letakkan
informasi berikut pada memori program”,
menggantikan SRAM, dimana biasanya
informasi tersebut disimpan.
Arduino Development Environment

Arduino  Development  Environment
terdiri dari editor teks untuk menulis kode,
sebuah area pesan, sebuah konsol, sebuah
toolbar dengan tomol-tombol untuk fungsi yang
umum dan  beberapa menu.  Arduino
Development Environment terhubung ke arduino
board untuk meng-upload program dan juga
untuk berkomunikasi dengan arduino board.

Sensor

Sensor adalah alat yang digunakan
untuk mendeteksi dan sering berfungsi untuk
mengukur  magnitude sesuatu. Dengan
menggunakan sensor kita dapat mengubah
mekanis, magnetis, panas, cahaya dan kimia
menjadi tegangan dan arus listrik. Sensor
yang digunakan pada sistem kontrol intensitas
penerangan lampu pada ruang baca ini adalah
sensor Infra Red.

LedInfra Red

Infra merah merupakan gelombang
cahaya yang tak tampak oleh mata manusia.
Panjang gelombangnya berada pada rentang
700 nm sampai 1 mm. Panjang gelombang ini
lebih panjang daripada panjang gelombang
cahaya tampak, tetapi tidak lebih panjang
daripada panjang gelombang radio. Sumber
cahaya infra merah hampir sama dengan
sumber cahaya tampak yaitu LED, tetapi
bahan pembuatnya berbeda. LED infra merah
dibuat dari bahan gallium arsenide (GaAs).
LED infra merah hanya memerlukan tegangan
masukan sebesar 3 Volt. Berikut adalah



Gambar 2.6 yang menampilkan bentuk fisik
dari led infra merah :

/V,
Gambar 2.6 : Led infra merah

Fotodioda

Fotodioda adalah komponen elektronik
yang terbuat dari bahan semikonduktor dan dapat
mengubah intensitas cahaya menjadi arus listrik
dan berikut bentuk fisiknya yang ditunjukkan
pada Gambar 2.7 berikut :

L

Gambar 2.7 : Fotodioda

Jika diperhatikan, skematik LED dan
fotodioda hampir sama. Perbedaan hanya
terletak pada arah panahnya saja. Pada
skematik LED, arah panahnya keluar, yang
dapat diartikan bahwa LED memancarkan
cahaya. Pada skematik fotodioda, arah
panahnya masuk, yang dapat diartikan bahwa
fotodioda menyerap atau memproses cahaya.

Seperti pada LED, fotodioda juga
memiliki dua kaki. Kaki yang lebih panjang
adalag anoda, dan kaki yang lebih pendek
adalah  katoda. Pemasangan komponen
fotodioda pada  rangkaian  elektronik
berkebalikan dengan pemasangan LED.
Kutub  positif atau anoda fotodioda
dihubungkan dengan kutub negatif sumber
tegangan, dan kutub negatif atau katoda
fotodioda dihubungkan dengan kutub positif
sumber tegangan.

Lampu Pijar

Lampu pijar adalah sumber cahaya
buatan yang dihasilkan melalui penyaluran
arus listrik melalui filamen yang kemudian
memanas dan menghasilkan cahaya. Kaca
yang menyelubungi filamen panas tersebut
menghalangi udara untuk berhubungan
dengannya sehingga filamen tidak akan
langsung rusak akibat teroksidasi. Lampu
pijar dipasarkan dalam berbagai macam
bentuk dan tersedia untuk tegangan (voltase)
kerja yang bervariasi dari mulai 1,25 volt
hingga 300 volt.Energi listrik yang diperlukan
lampu pijar untuk menghasilkan cahaya yang
terang lebih besar dibandingkan dengan
sumber cahaya buatan lainnya seperti lampu
pendar dan dioda cahaya, maka secara

bertahap pada beberapa negara peredaran
lampu pijar mulai dibatasi. Di samping
memanfaatkan cahaya yang dihasilkan,
beberapa penggunaan lampu pijar lebih
memanfaatkan panas yang dihasilkan,
contohnya adalah pemanas kandang ayam,
dan pemanas inframerah dalam proses
pemanasan di bidang industri.

Pengembangan lampu pijar sudah
dimulai pada awal abad XIX. Sejarah lampu
pijar dapat dikatakan telah dimulai dengan
ditemukannya tumpukan voltaoleh
Alessandro Volta. Pada tahun 1802, Sir
Humphry Davy menunjukkan bahwa arus
listrik dapat memanaskan seuntai logam tipis
hingga menyala putih. Lalu, pada tahun 1820,
Warren De la Rue merancang sebuah lampu
dengan cara menempatkan sebuah kumparan
logam muliaplatina di dalam sebuah tabung
lalu mengalirkan arus listrik melaluinya.
Hanya saja, harga logam platina yang sangat
tinggi menghalangi pendayagunaan penemuan
ini lebih lanjut.Elemen karbon juga sempat
digunakan, namun karbon dengan cepat dapat
teroksidasi di udara; oleh karena itu,
jawabannya adalah dengan menempatkan
elemen dalam vakum. Pada tahun 1870-an,
seorang penemu bernama Thomas Alva
Edison dari Menlo Park, negara bagian New
Jersey, Amerika Serikat, mulai ikut serta
dalam usaha merancang lampu pijar. Dengan
menggunakan elemen platina, Edison
mendapatkan paten pertamanya pada bulan
April1879.

Konstruksi

Komponen utama dari lampu pijar
adalah bola lampu yang terbuat dari kaca,
filamen yang terbuat dari wolfram, dasar
lampu yang terdiri dari filamen, bola lampu,
gas pengisi, dan kaki lampu. Berikut ini
adalah Gambar 2.9, yang menjelaskan tetang
bola lampu :

12.Bola lampu

13.Gas bertekanan rendah (argon,
neon, nitrogen)

14.Filamen wolfram

15.Kawat penghubung ke kaki tengah

16.Kawat penghubung ke ulir

17.Kawat penyangga

18.Kaca penyangga

19.Kontak listrik di ulir

20.Sekrup ulir

21.1solator

22.Kontak listrik di kaki tengah

Gambar 2.8 : Bola lampu dan keterangannya
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Bola Lampu

Selubung gelas yang menutup rapat
filamen suatu lampu pijar disebut dengan bola
lampu. Macam-macam bentuk bola lampu antara
lain adalah bentuk bola, bentuk jamur, bentuk
lilin, dan bentuk lustre. Warna bola lampu antara
lain yaitu bening, warna susu atau buram, dan
warna merah, hijau, biru, atau kuning.

Operasi

Pada dasarnya filamen pada sebuah
lampu pijar adalah sebuah resistor. Saat dialiri
arus listrik, filamen tersebut menjadi sangat
panas, berkisar antara 2800 derajat Kelvin
hingga maksimum 3700 derajat Kelvin. Ini
menyebabkan warna cahaya yang dipancarkan
oleh lampu pijar biasanya berwarna kuning
kemerahan.Pada temperatur yang sangat tinggi
itulah filamen mulai menghasilkan cahaya pada
panjang gelombang yang kasatmata.Hal ini
sejalan dengan teori radiasi benda hitam.Indeks
renderasi warna menyatakan apakah warna
obyek tampak alami apabila diberi cahaya
lampu tersebut dan diberi nilai antara O sampai
100. Angka 100 artinya warna benda yang
disinari akan terlihat sesuai dengan warna
aslinya. Indeks renderasi warna lampu pijar
mendekati 100.Berikut adalah Gambar 2.9, yang
menunjukkan bentuk kawat filamen lampu pijar.

Gambar 2.9 : Kawat filament

AC/DC Adaptor

Sebagian besar piranti elektronika
membutuhkan tegangan DC untuk bekerja.
Meskipun baterai berguna dalam piranti yang
bisa dibawa-bawa atau piranti berdaya rendah,
akan tetapi waktu operasinya terbatas. Sumber
daya yang mudah dapat dibuat dari sebuah
rangkaian yang dapat mengubah tegangan AC
menjadi tegangan DC.Sebuah adaptordapat
dibuat dengan tiga buah komponen utama, yaitu
transformer, dioda penyearah, dan kapasitor
filter. Transformator penurun tegangan adalah
transformator yangdiperlukan untuk
menurunkan tegangan primer yang tinggi
misalnyasebesar 220 Volt atau 380 Volt,
menjadi tegangan yang lebih rendah padabagian
sekundernya, 6 Volt, 9 Volt, 12 Volt, atau 24

Volt. Berikut adalah Gambar 2.10 yang
memperlihatkan bentuk fisik AC-DC adaptor :

<«

Gambar 2.10 : AC-DC Adaptor
Dasar - dasar ISP (In-System Chip
Programming)

In-System Chip Programming (ISP)
adalah sebuah fitur bagi sebuah microcontroller
agar dapat didownload dengan program tanpa
mencabut microcontroller dari system-nya.
Sehingga  Microcontroller  tetap  pada
kedudukannya semua dan dihubungkan dengan
ISP. Dan dilakukan proses download. Begitu
pula saat memutuskan hubungan antara
Downloader dan Microcontroller, kita hanya
cukup memutuskan kabelnya saja, tanpa lagi
perlu mencucuk-cabut microkontroler. Cara
semacam ini adalah cara yang sangat hemat
waktu terutama dalam proses pengembangan
sebuah program.

) A

Gambar 2.11 : USB — AT ISP programmer
download adapter

METODOLOGI PENELITIAN

Tempat dan Waktu Penelitian
Tempat Penelitian

Pembuatan dan pengujian sistem
kontrol penerangan listrik pada ruang baca
menggunakan sensor manusia dilakukan di :
3. Nama Tempat : Rumah Kontrakan
4. Alamat : JIn. Tangkul 1 No 110

Waktu Penelitian
Pembuatan dan pengujian sistem
kontrol akuaphonik ini membutuhkan waktu
dengan rincian sebagai berikut :
5. Peyediaan bahan dan alat  : 2 minggu
6. Perancangan seluruh sistem : 2 bulan
7. Pengujian sistem : 2 minggu
8. Penyusunan laporan Tugas Akhir : 3 bulan

Metoda Penelitian

Pelaksanaan penelitian ini dilakukan
dalam beberapa tahap untuk mempermudah
dan memperjelas arah penelitian.Berikut ini
adalah Gambar 3.1, yaitu flowchart kerangka
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berfikir dalam penelitian, dimana berdasarkan
flowchart inilah sebagai tahapan-tahapan
yang dilakukan oleh peniliti dalam melakukan
proses penelitian rancang bangun penerangan
listrik pada ruang baca menggunakan sensor
manusia:

Gambar 3.1 : Flowchart kgka berfikir

Alat dan Bahan

Alat-alat yang digunakan pada
pembuatan sistem adalah 1 set tools
mechanic, gerinda, bor listrik, solder listrik,
mistar, alat tulis. Alat-alat yang digunakan
pada uji kinerja alat rancangan antara lain :
multimeter, dan testpen.

Bahan yang digunakan dalam pembuatan
sistem kontrol intensitas penerangan lampu secara
umum adalah seperti pada Tabel 3.1 berikut :
Tabel 3.1 : Penetapan komponen (bahan)

No. Komponen No. Komponen
1 IC Mikrokontroler ATMega 328 11 DownloaderAT ISP
AC-DC Adaptor 12 VDC 12 Sistem Minimum Arduino Uno
DriverRelay 13 PCB Polos

2

3

4 Triplek 14 Dioda H-Bridge
5 Fotodioda 15 Led Infra Merah
6

7

8

IC Regulator 7805 16 Konektor 2 kaki
Konektor 4 kaki 17 Lampu Pijar 5 Watt
Resistor 18 Sekrup

9 Kabel Pelangi 19 Lem Syetan

10 Spicer 20 Steker Listrik 220 VAC

Rancangan Struktural

a. Rancangan dan Pembuatan Kerangka
Bagian rangka berfungsi sebagai dudukan
setiap sistem-sistem yang dirancang. Rangka
terbuat dari triplek dengan dimensi ketebalan
0,1 cm, panjang 32 cm, lebar 20 cm. Bentuk
kerangka sebagai dudukan secara keseluruhan
adalah triplek persegi panjang. Dimensi yang
dibuat adalah bertujuan agar alat mudah
dibawa kemana saja (portable). Rancangan
rangka dapat dilihat pada Gambar 3.2 di
bawah ini yaitu skema dalam bentuk diagram
satu garis :

Gambar 3.2 : Rancangan kerangka alat
b. Rancangan dan Pembuatan AC-DC
Adaptor
AC-DC adaptor yang dirancang adalah cukup
menggunakan AC-DC adaptor yang sudah

jadi  dan lebih simpel vyaitu dengan
membelinya di toko-toko penjual komponen
elektronika, namun hal yang harus
diperhatikan adalah spesifikasinya harus
sesuai dengan kebutuhan sistem yang
dirancang secara keseluruhan. Berikut adalah
Gambar 3.3 yang memperlihatkan bentuk
fisik AC-DC adaptor yang digunakan beserta
spesifikasinya yang tertera di badan adaptor :

Gambar 3.3 : AC-DC adaptor
Pada Gambar 3.3 di atas yang memperlihatkan
bentuk fisik AC-DC adaptor dapat juga dilihat
skema rangkaian didalamnya seperti Gambar
3.4 di bawah ini :
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Gambar 3.4 : Skema rangkaian AC-DC adaptor
c. Rancangan dan Pembuatan Beban
yang Dikendalikan

Seperti yang telah dijelaskan bahwa penelitian
ini adalah mencoba mengontrol penerangan
lampu pada ruang baca, maka dalam hal ini ada
pun beban yang dikendalikan tentu sudah
adalah lampu, namun lampu yang dikendalikan
adalah lampu pijar dengan spesifikasi daya 5
Watt dan bola lampunya berwarna merah.
Tetapi bukan berarti hanya lampu pijar saja
yang dapat dikendalikan semua lampu bisa
dikendali menggunakan sistem yang dibuat ini
asalkan lampunya menggunakan tegangan input
220VAC. Berikut adalah Gambar 3.5 yang
memperlihatkan bentuk fisik lampu pijar yang
digunakan :

Gambar 3.5 : Lampu pijar
d. Rancangan dan Pembuatan Driver
Relay
Seperti yang telah dijelaskan sebelumnya bahwa
driver relay adalah rangkaian elektronika yang
bisa mengendalikan pengoperasian sesuatu
dalam hal ini adalah relay. Relay yang memiliki
spesifikasi tegangan kerja 12 VDC tidak
mungkin langsung bisa dikendalikan oleh output
mikrokontroler, sedangkan output maksimum
mikrokontroler adalah sebesar 5 Volt. Oleh
sebab itu digunakanlah rangkaian driverrelay



agar relay inilah yang akan menyambungkan dan
memutuskan tegangan yang dibutuhkan pompa
akuarium, sedangkan untuk mengaktifkan
driverrelay dapat menggunakan output dari
mikrokontroler.

Adapun komponen elektronika yang dibutuhkan
dalam perancangan driverrelay adalah seperti
yang ditunjukkan pada Tabel 3.2 di bawah ini :
Tabel 3.2 : Komponen yang dibutuhkan
(driverrelay)

No. Nama Komponen Jumlah
1. SRD-5VDC (Relay) 1 Buah
1C 507F280 1 Buah
Resistor 1 kQ 3 Buah

Dioda Zener 1 Buah
Led model chip ¥, Watt 2 Buah
Transistor (2TY) 1 buah
7 Connector (cabang 3) 2 Buah

Berikut ini adalah Gambar 3.6, yang
memperlihatkan skema rangkaian yang
dirancang untuk driverrelay. Dan untuk
membuat skema tersebut pada PCB polos
dengan cara seperti metode pembutan AC-DC
adaptor yang telah dijelaskan sebelumnya, yaitu :
1. Mengambarkan skema rangkaian terlebih
dahulu menggunakan Software Eagle.

2. Mencetak pada kertas A4

3. Proses pelarutan dengan FeCls
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Gambar 3.6 : Skema rangrkaian driver relay
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e. Proses layout PCB

1. Membuka aplikasi Eagle 7.5.0. Setelah
halaman controlpanel muncul, lalu
mengklik File > New > Board untuk
menggambar tata jalur dan tata letak
rangkaian.

2. Berikut ini adalah Gambar 3.7 vyaitu
halaman board setelah melakukan
perintah di atas :

Gambar 3.7 : Halaman board
Halaman board memiliki beberapa fungsi
tools vyang dapat digunakan  untuk
menggambar PCB  vyaitu seperti yang
ditunjukkan pada Tabel 3.3 berikut :
Tabel 3.3 : ToolsEAGLEL.ightEdition

Nama Fungsi
Move Memindahkan posisi komponen
Copy Menggandakankomponen
Mirror Membalik komponen pada sumbu berbeda
Rotate Memutar sudut komponen
Group Mengelompokkan bebrapa komponen menjadi satu bagian
Change Mengubah parameter dalam menggambar PCB
Add Menambah komponen
Replace Mengganti komponen

Name Memberi nama komponen

Value Memberi nilai satuan komponen

Wire Membuat jalur antarkomponen

Text Membuat tulisan pada PCB

Circle Membuat lingkaran

Arc Membuat garis melingkar

Rect Membuat gambar kotak

Via Menggambar lubang komponen

3. Selanjutnya mengklik Add hingga
muncul halaman baru seperti tampak
pada Gambar 3.8 berikut :

o O

Gambar 3.8 : Memilih jenis komponen
Pada halaman Addterdapat tiga jenis frame
sebagai berikut :

- Frame untuk memilih  jenis-jenis
komponen elektronika. Ada ratusan
jenis komponen yang terdapat pada
library EAGLE layout.

- Frame untuk menampilkan gambar
komponen yang dipilih.

- Frame ini menampilkan keterangan
komponen, berupa nama, tipe, dan
ukuran komponen.

4. Selanjutnya pilih kategori kapasitor
dengan ukuran 5, 6, dan 7 mm, dan
mengklik OK, kemudian meletakkan
komponen pada board.

5. Kategori pin connector dengan mengklik
Add >Pinheadl x 3 sebanyak 1 buah.

6. Selanjutnya adalah proses pembuatan
tata jalur rangkaian dengan cara
mengklik Wirehingga muncul opsi baru
pada toolbar bagian atas.

7. Untuk memberi garis tepi rangkaian,
dengan mengklik Wire>Layer Dimension.
Selanjutnya membuat lubang spicerdengan
menggunakan toolViadan memilih nilai
drill sebesar 3,2 dan meletakkan lubang
spicer di setiap ujung PCB.

8. Gambar komponen tidak dibutuhkan
saat mencetak tata jalur. Oleh karena
itu, sebelum mencetak tata jalur,
menghapus gambar komponen terlebih
dahulu. Caranya, mengklik Display,
yaitu mengklik tanda biru pada nomor
21 dan 22. Secara otomatis, tanda biru
pada nomor 23 sampai 28 akan hilang.
Kemudian mengklik OK, dan tata letak
komponen akan hilang.

9. Mengklik Print, dan memberikan tanda
centang pada opsi Black dan Solid,



kemudian mengklik Page. Selanjutnya
mencetak tata jalur sebanyak 3 kali pada
kertas yang sama, dengan setting vertikal
top-center-bottom. Hal ini dilakukan untuk
membuat cadangan gambar jika terjadi
kesalahan pada proses pembuatan PCB.
selanjutnya mengklik OK.

10. Mencetak jalur PCB pada kertas A4.

. Proses Pelarutan PCB dengan Larutan

FeCls

Setelah mencetak tata jalur, tahap

selanjutnya adalah melarutkan PCB

dengan langkah-langkah berikut ini :

1. Memotokopi hasil cetakan tersebut
dengan menggunakan kertas
transparansi.

2. Menggunting hasil fotokopi gambar tata
jalur sesuai dengan garis tepi yang dibuat.

3. Menyiapkan PCB  yang telah
dibersihkan  dengan  menggunakan
kertas gosok tipis dan bilasan air.
Selanjuthya ~ memanaskan setrika
dengan suhu maksimal.

4. Menempelkan gambar tata jalur yang
telah digunting, dan memastikan bagian
yang terkena tinta (bagian yang kasar)
menempel pada PCB.

5. Menempelkan setrika panas di atas
kertas transparansi, lalu menekan dan
menahan selama 30 detik.

6. Mendinginkan PCB dengan
menggunakan air, dan melepaskan kertas
transparansi dari PCB secara perlahan.

7. Memotong PCB sesuai dengan garis
tepi gambar tata jalur rangkaian.

8. Melarutkan tembaga pada PCB dengan
menggunakan larutan FeCls, dengan cara :
- Menyiapkan wadah plastik dan air

panas, dan memasukkan FeCls
secukupnya, kemudian memasukkan
PCB pada larutan tersebut.

- Menggoyang wadah plastik secara
perlahan untuk mempercepat proses
peleburan tembaga pada PCB.

- Setelah proses peleburan selesai,
selanjutnya mengeluarkan PCB dari
larutan dan membilas dengan air.
Selanjutnya  menggunakan  kertas
gosok untuk membersihkan tinta-tinta
yang menempel pada PCB, hingga
jalur-jalur tembaga pada PCB terlihat.

- Mengeringkan PCB. Dan selanjutnya
proses pengeboran jalur-jalur
rangkaian yang berbentuk lingkaran
menggunakan bor listrik berdiameter
0,8—-1mm.

- Setelah dibor, tahap terakhir adalah
membersihkan PCB dengan
menggunakan  kertas gosok dan
bilasan air.

g. Perancangan dan Pembuatan Sensor
Infra Merah

Berikut ini adalah Gambar 3.9 yaitu skema

rangkaian sensor infra merah dalam penelitian

yang dibuat :

Gambar 3.9 : Skema rangkaian sensor infra
merah dan fotodioda
h. Rancangan dan Pembuatan Sistem
Minimum Arduino Uno
Gambar 3.10 di bawah ini adalah gambar
yang menunjukkan skema rangkaian dari
sistem minimum Arduino Uno beserta

Gambar 3.10 : Sistem minimum arduino uno

i. Perancangan dan Pembuatan Sistem
secara Keseluruhan

Dalam perancangan dan pembuatan sistem
secara keseluruhan berarti seluruh komponen
pembentuk sistem kontrol intensitas cahaya
lampu akan dilakukan  penggabungan
seluruhnya baik dari segi mekanik maupun
instalasi listriknya. Berikut Gambar 3.11 yang
menampilkan  skema rangkaian seluruh
sistem:

Gambar 3.11 : Skema rangkaian seluruh
sistem



Flowchart Sistem Kerja Alat

Berikut adalah Gambar 3.13 yang
memperlihatkan alur kerja sistem kontrol
intensitas penerangan;) pada ruang baca:

Gambar 3.13 : Flowchart sistem kerja alat

HASIL DAN PEMBAHASAN

Hasil Perancangan dan Pembuatan Alat
Dari hasil penelitian yang dilakukan,
dihasilkan suatu sistem kontrol intensitas kuat
penerangan lampu pada ruang baca berbasis
mikrokontroler ~ ATMega 328  sistem
minimum Arduino Uno sperti terlihat pada
Gambar 4.1 berikut :

Gambar 4.1 : Sistem kontrol penerangan
lampu pada ruang baca

Hasil Pengujian Alat

Setelah alat yang dirancang dan dibuat
sesuai konsep penelitian ini selesai dilakukan
maka tahap selanjutnya melakukan pengujian
alat secara keseluruhan, dimana kriterian
pengujian adalah sebagai berikut :

1. Pengujian kondisi lampu terhadap jumlah
orang yang masuk pada ruang baca.

2. Pengujian kondisi lampu terhadap jumlah
orang yang keluar dari ruang baca.

3. Pengujian kondisi lux cahaya lampu
terhadap jarak dari alat ukur lux meter
jika satu lampu yang hidup.

4. Pengujian kondisi lux cahaya lampu
terhadap jarak dari alat ukur lux meter
jika dua lampu yang hidup.

5 Pengujian kondisi lux cahaya lampu
terhadap jarak dari alat ukur lux meter
jika tiga lampu yang hidup.

Hasil Pengujian Kondisi Lampu terhadap
Jumlah Orang Masuk

Berikut adalah Tabel 4.1, yang menampilkan
hasil pengujian kondisi lampu terhadap
jumlah orang yang masuk:

Tabel4.1 :Hasilpengujiankondisi lampu
terhadap jumlah orang masuk

Jumlah
Orang Masuk

Kondisi
Lampu (1)

Kondisi
Lampu (I1)

Kondisi
Lampu (111)

0

Mati

Mati

Mati

Hidup

Mati

Mati

Hidup

Hidup

Mati

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

o|o|~|o|v|s]w|n|-

Hidup

Hidup

Hidup

Hidup

Hidup

Hidup

i

Hidup

Hidup

Hidup

Dari

Tabel 4.1

di

atas dapat dilihat bahwa

lampu akan menyala secara berturut, yaitu
jika tidak ada orang di dalam ruangan maka
lampu dalam kondisi awal yaitu semua lampu
kondisi mati. Dan ketika masuk satu orang
maka lampu (I) hidup dengan nyala yang
terang dan ketika orang kedua memasuki
ruang baca sehingga jumlah orang yang di
dalam ruang baca menjadi dua orang maka
lampu (1) hidup dengan nyala terang
sehingga total jumlah lampu yang hidup
adalah dua buah.

Hasil Pengujian Kondisi Lampu terhadap
Jumlah Orang Keluar

Berikut ini adalah Tabel 4.2, vyang
menampilkan hasil pengujian kondisi lampu
terhadap jumlah orang yang keluar :

Tabel4.2 :Hasil pengujian kondisi lampu
terhadap jumlah orang keluar

Jumlah Kondisi Kondisi Kondisi
Orang Keluar Lampu (1) Lampu (11) Lampu (111)

0 Tinggal 10 Orang Hidup Hidup Hidup
1 Tinggal 9 Orang Hidup Hidup Hidup
2 Tinggal 8 Orang Hidup Hidup Hidup
3 Tinggal 7 Orang Hidup Hidup Hidup
4 Tinggal 6 Orang Hidup Hidup Hidup
5 Tinggal 5 Orang Hidup Hidup Hidup
6 Tinggal 4 Orang Hidup Hidup Hidup
7 Tinggal 3 Orang Hidup Hidup Hidup
8 Tinggal 2 Orang Hidup Hidup Mati
9 Tinggal 1 Orang Hidup Mati Mati
10 Tinggal 0 Orang Mati Mati Mati

Dari Tabel 4.2 di atas dapat dilihat bahwa
lampu akan mati secara berturut, yaitu jika
tidak ada orang di dalam ruangan maka lampu
akan kembali dalam kondisi awal yaitu semua
lampu kondisi mati. Dan ketika keluar 8
orang dari 10 orang maka lampu (l1I) mati
dan ketika 9 orang keluar dari 10 yang ada di
dalam ruang baca maka lampu (II) mati.
Selanjutnya ketika 10 orang total jumlah yang
keluar maka lampu (1) mati sehingga total
jumlah lampu ketiganya mati.

Pengujian Kondisi Lux Cahaya Lampu
terhadap Jarak (Satu Lampu)

Berikut ini adalah Tabel 4.3 vyang
menampilkan hasil pengujiankondisi  lux
cahaya lampu terhadap jarak dari alat ukur lux
meter jika satu lampu yang hidup :



Tabel 4.3 : Hasil pengujian lux 1 lampu
terhadap jarak

40 cm 100 Lux
20cm 200 Lux
15cm 300 Lux
13cm 400 Lux
10cm 500 Lux
9cm 600 Lux
8cm 700 Lux
7cm 800 Lux
9. 6.cm 900 Lux
10. 5cm 1000 Lux

Dari Tabel 4.3 di atas dapat dilihat bahwa
kondisi lux meter yang terbaca terhadap
kuantitas cahaya lux dari satu lampu pijar yang
hidup dengan spesifikasi lampu pijar 5 Watt
adalah semakin dekat jarak lux meter dengan
lampu pijar maka kuantitas lux cahaya lampu
semakin besar, dan sebaliknya jika jarak lux
meter dengan lampu pijar semakin jauh maka
kuantitas lux cahaya lampu semakin kecil.

N o[

Pengujian Kondisi Lux Cahaya Lampu
terhadap Jarak (Dua Lampu)

Berikut ini adalah Tabel 4.4 vyang
menampilkan hasil pengujiankondisi  lux
cahaya lampu terhadap jarak dari alat ukur lux
meter jika dua lampu yang hidup :

Tabel 4.4 : Hasil pengujian lux 2 lampu
terhadap jarak

70 cm 100 Lux
30cm 200 Lux
24 cm 300 Lux
22 cm 400 Lux
19cm 500 Lux

17cm 600 Lux
16 cm 700 Lux
15cm 800 Lux
9. 14 cm 900 Lux
10. 13cm 1000 Lux

Dari Tabel 4.4 di atas dapat dilihat bahwa
kondisi lux meter yang terbaca terhadap
kuantitas cahaya lux dari dua lampu pijar yang
hidup dengan spesifikasi lampu pijar masing —
masing 5 Watt adalah dimana semakin dekat
jarak lux meter dengan kedua lampu pijar maka
kuantitas lux cahaya lampu semakin besar, dan
sebaliknya jika jarak lux meter dengan kedua
lampu pijar semakin jauh maka kuantitas lux
cahaya lampu semakin kecil.

Dalam hasil pengujian di atas dapat dilihat
bahwa perbedaannya dengan pengujian untuk
satu lampu vyaitu jarak antara lux meter
dengan lampu lebih jauh dibandingkan
dengan yang satu lampu dimana kuantitas lux
yang dihasilkan adalah sama.
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Pengujian Kondisi Lux Cahaya Lampu
terhadap Jarak (Tiga Lampu)

Berikut ini  adalah Tabel 4.5 yang
menampilkan hasil pengujiankondisi  lux

cahaya lampu terhadap jarak dari alat ukur lux
meter jika tiga lampu yang hidup :

Tabel 4.5 : Hasil pengujian lux 3 lampu
terhadap jarak

90 cm 100 Lux
50 cm 200 Lux
45cm 300 Lux
40 cm 400 Lux
35cm 500 Lux
33cm 600 Lux
32cm 700 Lux
3lcm 800 Lux
9. 30cm 900 Lux
10. 29 cm 1000 Lux

Dari Tabel 4.5 di atas dapat dilihat bahwa
kondisi lux meter yang terbaca terhadap
kuantitas cahaya lux dari tiga lampu pijar yang
hidup dengan spesifikasi lampu pijar masing —
masing 5 Watt adalah dimana semakin dekat
jarak lux meter dengan ketiga lampu pijar maka
kuantitas lux cahaya lampu semakin besar, dan
sebaliknya jika jarak lux meter dengan ketiga
lampu pijar semakin jauh maka kuantitas lux
cahaya lampu semakin kecil.

Dalam hasil pengujian di atas dapat dilihat
perbedaannya yaitu lebih jauh jaraknya antara
lux meter dengan lampu dengan kuantitas lux
yang sama dibandingan dengan jarak untuk
satu lampu dan dua lampu yang hidup.
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Hasil Pengujian Kondisi Lampu Pijar
Dalam pengujian kondisi lampu pijar cukup
simpel karena hanya menghubungkan
fittingnya bersama lampu pijar didalamnya
dengan aliran listrik PLN 220 VAC.

Ternyata setelah diuji maka hasil pengujian
lampu pijar dapat dilihat seperti pada Tabel
4.6 berikut ini :

Tabel4.6 :Hasil pengujian lampu pijar

Pengujian Aliran Listrik 220VAC Kondisi Lampu
| Terhubung Hidup
1 Tidak Terhubung Mati

KESIMPULAN DAN SARAN

Kesimpulan
Dari hasil penelitian yang dilakukan
maka dapat diambil kesimpulan sebagai berikut :

1. Sistem kontrol intensitas kuat penerangan
lampu pijar mampu memenuhi syarat dari
tujuan  penelitian  dengan indikator
intensitas penerangan lampu pijar dapat
dikendalikan sesuai jumlah orang yang
masuk dalam ruang baca.

2. Tingkat ketelitian pendeteksian sensor infra
red mampu memenuhi syarat dengan
mendeteksi jumlah orang yang masuk pada
ruang baca dengan mengontrol 3 buah lampu.



3. Dengan sistem pengendali 1C mikrokontroler
ATMega 328 dapat melakukan proses
pembacaan data dengan adanya orang yang
masuk dan Kluar dari ruang baca.

Saran
Adapun yang menjadi saran pada
penelitian ini adalah :

1. Untuk kesempurnaan alat ini kedepannya
alangkah baiknya sistem rancangan alat dapat
diimplementasikan  secara  langsung  di
lapangan dengan mencocokkan nilai intensitas
penerangan dengan standart yang ada.

2. Alat ini bekerja baru sebatas dapat
mengendalikan secara otomatis intensitas
penerangan melalui jumlah lampu pijar
yang mesti hidup pada ruang baca.

3. Jika ingin mencocokkan nilai standart
intensitas yang ada terhadap cahaya yang
dikeluarkan oleh lampu pijar maka cukup
mengganti lampunya saja dengan lampu pijar
yang nilai Watt-nya lebih besar sesuai standart.
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